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This LISA Web 2.0 guide user documentation is divided into six parts.

PART 1 - LISA Web 2.0 - User Guide
PART 2 - LISA Web 2.0 - How Tos
PART 3 - LISA Web 2.0 - Reference
PART 4 - LISA Web 2.0 - Videos
PART 5 - LISA Web 2.0 - Repository
PART 6 - LISA Web 2.0 - FAQ

PART 1 - LISA Web 2.0 - User Guide

PART 1 - LISA Web 2.0 - User Guide

Recording a Web Site via DOM Events
LISA Web 2.0 testing, works by letting LISA emulate a web browser.

LISA Web 2.0, allows you to record events at the DOM (Document Object Model) level (such as mouse clicks, mouse movements, keys being
typed, etc.) and play those events back as a browser during test execution.

DOM-level testing gives you fine-grained control over what a test can and cannot do, what type of object it can access and what kind of result it
can return. In particular, all client-side logic is accessible to it. A Web 2.0 test can easily interact with frames, JavaScript, CSS, Ajax, Plugins,
Applets and so forth. Many modern web sites make heavy use of these technologies, Ajax in particular, and those are usually called Web 2.0
sites, hence the term Web 2.0 tests. However, any web site can be tested in this fashion.

For more information on Web 2.0, you can also refer to its How To doc and Reference Guide in the LISA Web 2.0 Guide.

The following topics are available in this section.

. Introduction to Web 2.0

. Recording Mode

. Playback Mode

. Edit Mode

. Debugging

. Setting up ADF Extensions

. Running Browser Standalone
. Troubleshooting

. Known Limitations
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1. Introduction to Web 2.0

1. Introduction to Web 2.0

One of the major strengths of LISA is its outstanding ability to create and run tests that make use of a mix of different technologies (web, j2ee,
web services, swing, etc...) as is so often necessary in the enterprise software world.

Web 2.0 tests are no exceptions in this regard and can be mixed with any other type of step. Nothing special is required to achieve this.
Until version 3.5, LISA has fully supported HTTP-level web testing and it will continue to do so in future releases.

HTTP-level testing works by having LISA install a proxy between itself and the web server. It then captures the HTTP and HTTPS traffic flowing
between the client and the web server during a recording session. It submits GET or POST requests during a playback session. For more details



you can consult the LISA web testing chapter in the User Guide.
Later, LISA supported the testing and recording of the Web 2.0 browser. By contrast, the Web 2.0 testing works by letting LISA emulate a web
browser. It allows you to record events at the DOM level (such as mouse clicks, mouse movements, keys being typed, etc...) and play those
events back as a browser during test execution.
There are advantages to each approach:
The HTTP-level testing might be more resistant to client-side changes during test execution since it is only aware of URLs. In addition, it is very
lightweight so it is well suited to massive load-testing. DOM-level testing however is more resistant to server-side changes, it gives you much
finer-grained control over what a test can and cannot do, what type of object it can access and what kind of result it can return. In particular, all
client-side logic is accessible to it. A Web 2.0 test can easily interact with Frames, Javascript, CSS, Ajax, Plugins, Applets and so forth. Many
modern web sites make heavy use of these technologies, Ajax in particular.
In addition to web testing, the LISA Web 2.0 can record, replay, and validate other so-called RIA (Rich Internet Applications) such as Java Applets
(Swing and AWT), ActiveX controls and in particular Flash and Flex applications.

The following topics are available in this section.

1.1 System Requirements

1.2 Technologies and Platforms
1.3 Getting Started with LISA Browser

1.1 System Requirements

1.1 System Requirements

In addition to the LISA installation on a Windows NT or better machine, the following is also required.
® Aninstall of the .NET 2.0 SP1 runtime (or newer)
® A public jre (1.4 or greater) if you intend to test java applications or use HTTP recording

1.2 Technologies and Platforms

1.2 Technologies and Platforms

Web 2.0 tests might be better described as GUI tests because they support a lot more than basic web tests.

In the pure web realm, any server side-technology or platform is supported (because it's irrelevant from the client's perspective), whereas on the
client side Web 2.0 can run Internet Explorer, Mozilla Firefox, or Safari (initial support) making it a truly cross-browser solution (those browsers
constitute about 99% of the browser market at the time of this writing).

In addition to web testing, Web 2.0 can record, replay and validate other so-called RIA (Rich Internet Applications) such as Java Applets (Swing
and AWT), ActiveX controls and in particular Flash and Flex applications.

Finally Web 2.0 supports non-web hosted technologies. It can record, replay and validate Java desktop applications (Swing, AWT), .NET
WinForms or native Win32 applications.

Important Note: The support for all these technologies is deep and does not rely on so-called analog record and replay technology that many
tools only have. Analog testing is technology-agnostic because it relies on screen coordinates, which makes it very brittle and not very powerful.

1.3 Getting Started with LISA Browser

1.3 Getting Started

To open the Web Browser,

7

® Click the icon on the test case menu. This will open a menu further -




@ t;ﬁ '-.-'I.I'E;I:u Recorder (HTTP praoxsy)  Chel+Shift+R
@ Web Recorder (DOM Events)  Crrl+Shift+6
2 HTML Interface Recorder
<# Java Interface Recorder
% Net Inkerface Recorder

¥ Mative Interface Recorder

Click Record Test Case for User Interface > Web Recorder (DOM Events)...
Or click Actions > Record Test Case for User Interface > Web Recorder (DOM Events) from the main menu.
This allows you to launch the browser that LISA uses to record and playback Web 2.0 tests.

The first time the browser is launched; there is a wait dialog that indicates it is synchronizing its initial state with LISA. Subsequent invocations will
not do this since synchronization will happen on the fly.

Typically, the first interaction you will have with a web test is of recording a session.

Once you open the Web Browser, by default it opens in the Recording mode.
-~

8% Lisa Browser (4.8.4.0) {gourik) [Unnamed] about:blank

! File Edit Commands Help

iMnde $ @ | 0 e@ 3¢ Y Address @ - | Actions [ - =0 -3 -00 | @ S @& @

Welcome to the LISA UI Tester. Please choose from one of the following options:
@ Record or edit 3 Web test case by typing the URL of the target website above.

@ Record or edit a Java test case by clicking here.

'@' Record or edit a Native test case by clicking here.

@ or start with one of the previously visited targets below... [Clear History]

iTKO - LISA Virtualiz...

[
| ™

frogess [ W -

There are three main sections in the Web 2.0 Recorder:
® Recording Mode
® Editing Mode
® Playback Mode

Within the browser, there are menus which allow you to Record or edit a Web or Java or a Native test case.



You can also see the recently opened web pages if there are any recordings done previously.

More details regarding the same can be found in the subsequent sections.
1.3.1 Browser Menu

1.3.2 Browser Toolbar

1.3.3 Browser Settings

1.3.4 Browser & Extension Updates
1.3.5 Browser Architecture

1.3.1 Browser Menu

1.3.1 Browser Menu

The LISA Browser opens in the Recording mode by default. The LISA Browser has a typical main menu and a toolbar, which has functions and
icons depicting various activities or actions.

Browser Menu

The Browser menu is as shown below and explained.

: File Edt Commands Help

File Menu

File > Load — Loads the current web address

File > Save — Saves the current recording

File > Save As — Saves the current recording under a different name
File > Close — Closes the current recording

File > Exit — Exits the LISA Browser

Edit Menu

Edit > Pause Recording — Pauses the recording

Edit > Clear Steps — Clears all steps

Edit > Browser Settings — Opens the Settings dialog box, where you can set the browser settings.

Edit > Internet Options — Opens the Internet Properties dialog box, where you can set the Internet options.

Commands Menu

Commands > Back — Loads the previous page

Commands > Forward — Loads the next page

Commands > Reload — Reloads the page

Commands > Stop — Stops the recording

Commands > Toggle Debug Window — Toggles the debug window
Commands > Capture Session — Captures the current recording session

Help Menu
Help > Documentation — Opens the documentation page for LISA web 2.0

Help > Browser Updates — Opens the LISA Component update dialog box.
Help > Extension Updates — Opens the LISA Extension update dialog box.

1.3.2 Browser Toolbar

1.3.2 Browser Toolbar

The LISA Browser opens in the Recording mode by default.

The LISA Browser has a toolbar as shown below:
I Mode o & | @ @ 5t “  Address |http:f wvwitka, com) v |G - | Actions [ -0 - 3 - 10 @ . @ @I

On the left of the toolbar, there is the Mode button, where in you can select the Mode of operation within the browser:

® Recording Mode - Where you can record the operation.
® Edit Mode - Where you can edit the transactions.



® Playback Mode - Where you can playback the recorded operation.
By default the Recording mode is selected.
You can Record the web page and playback the recording by clicking on the Playback mode.
You can click on the Edit mode to view add/delete the Logical, Physical events and view the Object details which are described later.

There are the usual Web page buttons to take you — Back, Forward, Reload, Abort and Home page.

,é:, 'Ef _k ..-*lw-..

You can enter the Web page address in the Address bar provided or select the "Go" button to navigate and open HTML/ Java/.Net or Native
age.

Address |abaut:blank w || - | Actions [ -0+
% Mavigate L
% Browse for HTML |
¥ Browse for Java
#5 Browse for JMET
&' Browse For Native

You can Load and Replace or Load and Append from the "Actions" button. The Load button is not normally used when using the browser within
LISA. It is useful when using the browser is standalone. You can either Load and Replace or Load and Append a previous recording here.

Ll

Load and Replace

Load and Append

You can Save the recordings from the "Save" button. The Save button is what commits the recording to LISA's Test Case, and closes the
browser.

If you are in standalone mode it saves the recording to a file. You can do a Save, Save as or Capture a Session here.

|l -

Save
Save As

Capture Session

You can Close and Cancel the recording from the "Cancel" button. The Cancel button simply discards the current recording and closes the
browser without modifying the Test Case. The window close button has the same effect. You can also Clear all previous Events here and Exit
from the Recording window here.

i -

Cancel and Close
Clear all Events

Exit

The following icons are described below:

0| @ 5 & @

Icon  Description

nn The Pause button allows you to navigate without recording. Recording resumes when it is pressed again. It is useful to skip some
undesired events.

e The Debug button allows you to open or close the debug window.




The Settings button opens the Settings dialog that allows you to configure global behaviors of the both the recorder and the debugger.

u‘j'ﬁ The Pin window button makes the browser (in recorder or debugger mode) stay as a topmost window, which means that it will stay on
top of any other window on the screen, even if it does not have the focus. This is useful when you want to observe the tests running
while other windows try to grab the focus, especially when you test external applications (like Swing or .NET Winforms).

@ The Help button displays the download area from where you can download this document.

The Debug i and the Settings buttons are described in detail in the next section.

1.3.3 Browser Settings

1.3.3 Browser Settings
The LISA Browser Settings allows you to control how the Recording and Playback will work.
From the main menu, click Recording > Settings or Click the Settings icon from the top right toolbar.

The Settings are divided in 4 sections: General, Recording, Playback and Environment.

While the settings window is open, you can quickly lookup the meaning of a setting by clicking the icon at the top right corner of the window
and then the desired setting, or position the mouse over the desired setting and type the F1 key. You will get a tooltip for that field as shown

below:

Log Settings
Log Meszages to Quput
Log Messages to file

Log statements of severity

Debug and higher.

() wWarning Lewvel
) Error Level

Each playback setting can be overridden on a per test case basis by defining a property (usually but not necessarily in the configuration of the test
case or suite), whose name is indicated in the reference and in the help pop-up described above.

For example, there is a setting called "Synchronize Ajax Calls" (which is used to force the browser to treat all ajax calls as synchronous calls). If
you bring up the help pop-up you will see this setting can be overridden with the SYNC_AJAX property, which means if a test case defines the
SYNC_AJAX property with an appropriate value (true or false in this case), the behavior for this test case as defined by this property will override

the one defined in the settings window.

General Tab

The General Tab is used to set basic options.



5k Settings

General | Recording | Playback | Environment

| @ For help click onthe 7 icon in the top-right comer, then on a setting's label. Save l [ Cancel

Information

BUILD: 4.8.4.0 [LATEST AVAlLABLE: 4.8.4.0)

MACHINE: GAJRILAPTOP

05: Microzoft Windows MT 51,2600 Service Pack 3

IE: 8.0.6001.18702  Firefox: 2.6

MET: 20507273615 JRE: 0.0

E=E: "C:\Liza5.0GAMbin,browsersliza_browser.exe’ -m recorder -p 2641 -pid 2556
MEMORY: 36341 KE

General Behavior Log Settings
[] Dizable browser popups Log Meszsages ta Duput Windaw
[] Hide Errar Dialogs Log Messages to file
[] Enable fctivel / Flash / Flex [beta (%) Debug Level
Enable Applets [Meedsz public JRE] (3 Info Level
Capture HTTP traffic [Meeds public JRE] () Warning Lewvel

Enable Pathfinder Integration [Meeds public JRE] ) Emor Level

[] Enable SWT [preview] Cuztom HT TP Headers [requires restart]

Remaote Applications Port |0

4

Mame YWalue

k asimurm B andwidth 0 KB/

L

Output Directary | {({BEROWSER_HOME Hsout
Scrptz Directary | {{BROWSER_HOME Hscripts
Mapz Directory | H{EROWSER_HOME Mmaps

In the Information box — you can see the machine information which runs LISA browser

In the General Behavior box — you can check/uncheck general behavior of the browser properties.

In the Log Settings box — you can check/uncheck log related information.

Disable browser popups: acts like a popup blocker. Overrideable in a test with DI SABLE_POPUPS.

Suppress Javascript Dialogs: alert and confirm dialogs will auto-respond during playback SUPPRESS_DI ALCGS.

Enable ActiveX / Flash / Flex: Turns on support for ActiveX events. Only reason to turn it off might be faster startup time.

Enable Applets: Turns on support for ActiveX events. Only reason to turn it off might be faster startup time or improved stability (the
Java Plugin Interface has some known bugs in certain versions of it, notably 1.5.0_01 through 1.5.0_14, that could cause crashes).
Enable SWT: Turns on support for testing non-Eclipse based SWT applications.

Capture HTTP traffic: Turns on a proxy to capture all HTTP(S) traffic and stores all headers in the event requests. Only reason to turn it
off might be faster startup time or already having a proxy.

Enable Pathfinder integration: this causes the browser to receive and decrypt Pathfinder payloads for Pathfinder-enabled applications.
Remote Applications Port: specifies the port to use the control remote applications (Swing, SWT or WinForms). The default, 0, picks
the port dynamically.

Maximum Bandwidth: throttles request and response speed to simulate a network with the specified throughput. 0 means no limit.



® Log messages to Output window: self-explanatory.
®* Log messages to Output file: self-explanatory. The log files go in the same directory as the DOM browser.
® Log Level: the level of log statements required to be logged in the Ouptut window or file if turned on above.

Recording Tab

The Recording Tab is used to set Recording options.

=
] Settings
General 0| Playback | Ernviranment
Fecarding Strateqgy Recarding Optionz
All

IJze context menus for filkers and aszertions

lghore ids and names whose value matches: . i .
. [] wiite Traffic to Disk

i3, L
3 Compress recarding files
[] Externalize recorded texst

Capture Lewvel
DOM
[] Capture DOM Lewvel 2

[gnore frame names whose value matches: ]
[] “erbose HTML recording

[] Ignare HTML responzes

Ignore text whose value matches: [ Capture HTML changes

AB4}
] Capture &pplet snapshots

IJze the following attributes [in this order]: )
[] Capture &ctivel snapshots
1] Bl | <noner W
Capture Diff Size Bytes
2] Bl | <none: w )
Capture Max Time ms
3 | <nomes “ 7| <nones w

Capture DOM Events
4] | <noner W ]|

_ _ _ _ navigate docload
Or uge the fallowing locator javascript function foous dblclick
O rouzedomn change
| ghore invizible elements —— contextmeny
Java MOUSE0vEr drag/drop
Record using: [ mouseout mouzemave
[] Component names Deep paths click keypress
Component text Geometry opendclose [ ajax callback
@ Far help click an the 7 icon in the top-right cormer, then an a setting's label. [ Save l [ Cancel

Use context menus for filters and assertions: Override the right-click menu in web pages to popup a custom menu that offers choices
about filters, assertions or debugging. Turn it off it your site already uses custom context menus.

Capture applet snapshots: stores in the test the applet screenshots used in applet test editing (browse mode). Turn it off if the tests get
too large.

® Compress recording files: keep that turned on (used for debugging).

Verbose recording: Records events for which we could not detect an event handler (possibly DOM Level 2). Turn it off for most sites, try
to turn it on if you notice some necessary event does not get recorded (happens using ExtJS for instance).

Capture HTML changes: Store the HTML at any click or change event to make it easier for later editing.

Capture Diff size: changes over this size will store the whole response, changes under this size will stotre the diff.



® Capture Max time: the diff above won't be captured if it takes more than this amount of time.

® Save Dialog Triggers: for pages with a non text/plain mime type, this decides whether to pop up a "Save As" dialog instead of
performing a navigation if the target url matches the regular expression (by default, it does this for Excel, Word, PDF, Text, PowerPoint,
Executable and Zip files).

® Recording strategy: which HTML attributes to use and in which order when generating XPath expressions.

® Exclude Ids matching: any element id matching this regular expression won't be used in the auto-generated XPaths.

® Record component names/text: use java component names or text (or not) in the XPath generated when recording Java based
applications.

® Capture DOM events: Turn off any type of DOM event you're not interested in capturing.

Playback Tab

The Playback Tab is used to set Playback options.

=
i Settings
General | Recarding |: F Erviranment
Flavback Optians Timeout Settings
[] Supress Javascript Dialogs DOk Load Tirmeout 10000 *| me
[ Show Browser Dialogs DOM Lockup Timeowt  [1000 2| ms
[] Synchronize &jax calls.
L] Use Hardware Input Applet Load Timeout — [10000 2| me
[ Enable mause mavement Applet Lookup Timeout 5000 & ms
[] Send Fezponses back to LISA
M ax missing targets |2 - Active Load Timeout 10000 2| ms
(o el see | - Activers Lookup Timeout 5000 2| ms
Failed azsertions screenshot direchany:
Flavback Speed [left iz slowest - right i fastest]
What multipher: O
Browser Options
Iz& the following browsers by default: Installation Directories;
Internet Explorer C:%Program FilessJrnternet Explon s
] Firefox C:%Program FileshMozilla Firefox B
[] Safari
@ Faor help click an the 7 icon in the top-right cormer, then an a etting's label. Save ] [ Cancel

Of particular interest on this tab is the Synchronize Ajax calls checkbox. This if checked, the step will not return until the Ajax call completes.

® Fail step on missing target: Generates a failure instead of the default warning when a target can not be found for a step (that includes



browser window, frame, element). Overrideable in a test with FAl L_M SSI NG

® Synchronize Ajax Calls: forces all ajax calls to be executed synchronously. Overrideable in a test with SYNC_AJAX.

® Use Hardware Input: Replays tests by controlling keyboard and mouse. Overrideable in a test with USE_HARDWARE.

® Send Responses back to LISA: By default responses will not be sent back to LISA to improve performance and memory since it's
usually not necessary.

® Min Matching Score: How many differences are allowed between a recorded XPath value and the best match found during playback.
Overrideable in a test with M N_BACTRACKI NG

® Default Browser Mode: What browsers to enable by default during playback (pipe-delimited combination of IE, FF and WK).
Overrideable in a test with DEFAULT_BROWBER.

®* Playback Speed: The default speed to use to replay test as a multiplier of the recorded speed. Ox is usually the best choice.
Overrideable in a test with PLAYBACK_SPEED (integer between and 10).

® XXX Load Timeout: The maximum amount of time waited before a new page/applet/control load before proceeding. Overrideable in a
test with XXX_LOAD_TI MEQUT.

® XXX Lookup Timeout: The maximum amount of time waited to find an element on a page/applet/control before proceeding.
Overrideable in a test with XXX_LOOKUP_TI MEQUT.

Environment Tab

The Environment Tab is used to display the Environment settings.



[~ i
i Settings @EI
General
=T YWalue L
{ftcomitko.liza stats jme I TEOAgentC... LISA_JM=_ITEOAGENT
{ikcom.itko.liza stats jme.JBossConnec...  LISA_JM<_JB0S53240%
{fhcom.itko.liza stats e SRTE0RMIC...  LISA_JM=_JSR1GORMIN
{fhcomn.itko iza stats e OracleSCon... LISA_Jbx=_0C41%
{ftcom itk liza stats jme. TormeatConn... LISA_JM_TOMCATEN
{Tcom.itko.liza stats jmeweblogicSCao...  LISA_JM=_WwL5 9N
{tcom.itko iz stats jmeweblogicCon... LISA_JM=_w/L56781%
{ihcomn.itko iza stats e websphereS. . LISA_JM=_twW/ASS 04PN,
{0 atelt LI-DD-DDDD
ESSMH DOD-DOD-DDDDN
{8Zipht 07a]
i UPDATE_DEY DISABLED} false
{_UPDATE_DISABLED} falze
{1alt liza. simulator. webservice.classpat... A
{{apple. avt. brushid etall ook} false
{{apple.laf uzeScreentd eruB art b
{{BROWSER_HOME} C:MLizah 0GANbIRSbrowser
{{com. apple. macos. smallT abs}} true
{{carn. apple. . application. growbox.in,.. e
{carmitkolisa, stats jme | TEDAgentCa. .
{{oom. tko.liza. stats . BossConnech...
{{com. itko.liza. stats. jmx WeblogicConn...
{{DEY_SERVER_ROOT_PATHH hbtp: & A itk o, comd download/releaselisa_browser desw/
{{eclipzelink. ddl-generation. output-mad... - database
{eclipzelink. ddl-generation}} create-tables
{{eclipzelink. jdbc. drivert} {1lizadb.driver}}
{{eclipselink. jdbc. password) {{lizadb passward}
Heclipselink. jdbc.url}} {{hzadburll}
{eclipzelink. jdbe. uzer}} {lizadb uzemamne}t
{{eclipzelink.target-databaze}} {1lizadb. eclipselink.target-databaze}}
{{eclipselink. validateschemalt false
HEXAMPLES. HOME ! fiLISA_HOME}esamples
{{Hle. encoding UTF-8
{1Functional Repart, com/itkoslizasrep...
{qui. show. rnemiony, status false
{fice.brovwzer http.agent} Mozillasd.0 [zompatible; MSIE B.0; Windows NT 5.0
{ITKO_COMMECTED} brue
{Hjazper.multi.report}} Y
{fjasper single.repart Y i
'@' Faor help click an the 7 icon in the top-right cormer, then an a etting's label. Save ] [ Cancel

This tab shows the list of global environment variables available to the browser, as read from lisa.properties and local.properties.

LISA Driver Settings:

In addition to the settings above that can be overriden from LISA in a test case or in the local.properties, the following are available:

lisa.browser.launch.timeout: The amount of time allowed for a browser to launch (default is 10,000). Specify in local.properties.
lisa.browser.exec.timeout: The amount of time allowed for a step to execute (default is 300,000). Specify in local.properties.
lisa.browser.max.instances: The maximum number of browser instances per machine (default is 25). Specify in local.properties.
lisa.browser.client.user.single: Whether to run staged browsers using the same user account as the currently logged-in users (default
is true). Specify in local.properties.

lisa.browser.base.port: The first port to use in the range of ports available to control web browsers (default is 0 for dynamic value). This
normally does not need to be modifed except in very secure environments that lock down some local ports. Specify in local.properties.
lisa.browser.client.user.<user name>=<encrypted password>: when lisa.browser.client.user.single is set to false, browser instances
will use the specified windows user accounts to run tests. If not enough user accounts are specified in this manner and the currently
logged-in user has admin privileges, user accounts will be dynamically created to run the tests (and deleted at the end). To obtain an
encrypted password, run the command line: lisa_browser.exe -m encrypt -in <clear text>.



® |isa.browser.share.subprocess.state: Whether to run a sub-process using the same browser instance as parent test (default is false).

Specify in configuration of sub-process.
® lisa.browser.swing.port: The first port to use in the range of ports available to control Swing applications (default is 0 for dynamic

value). Specify in local.properties.
® |isa.browser.base.port: The first port to use in the range of ports available to control web browsers (default is O for dynamic value).

Specify in local.properties.
1.3.4 Browser & Extension Updates

1.3.4 Downloading Browser and Extension Updates

Because the web 2.0 environment evolves so fast, there is the ability to update it directly without waiting for a whole LISA release. Note that these
intermediate releases are considered unsupported, but since most customer environments are not available to the outside world, we can not test
a bug fix or feature enhancement against them so we work through this mechanism to allow a fast turnaround cycle. When the changes have
been approved by a customer they are submitted to the official build environment for full testing.

One way to obtain the update is to run the update command from the command line:

lisa_browser.exe -m udpate.

Or you can do it from the GUI by going to the Help menu and selecting the Update menu.
To download the updates of the web 2.0 browser,
Open the Web 2.0 browser within LISA.

® Click Help > Browser Updates to open the following dialog:
;Er,;, LISA Cormponent Update @

Auto-download a new version of the LISA Ul Recorder and Debugager.
Or peform a manual download by clicking nere

Download Settings
Server [TKO download server -

Usemame iTKO-Contractor/gaur kulkami

Password essssssssss

Version 4340 b

Progress

Duwnluad] [ Cancel

Click Download to start the download. You can monitor the download progress though the progress bar.
After the download is completed you will be notified that the update will be effective on restart.

Finally, when major new functionality is added, some dependencies will be added or modified that won't be available until you install from a full
LISA installer.

This is why the browser checks for those on start up and prompts you for a download on start up if they are missing:



| i Dependencies Download E“E”cs__( |

@ The follawing files are mizzing and should be downloaded for the current
wergion of the liza broveser bo work:

[¥] Interop.wiebKit.dil [Basic Safar functionaliy]
([#] injectordil fafinForms functionality]

i dotnet-monitor.dll [winForms functionality]
; dotnet-callback.dil PwinFarms functionality]
{[#] swingcalback.jar [Swing functionality]

Download from i-ITKEI download server

| =
|l zermame [ riigel. tufnel

|
PaSSWDrd ill-III-IIIOIII-IIIOIII-III-III-I

D awrload status [

Download ][ Cancel ]

The browser won't start until those missing dependencies have been downloaded from one of the available locations: one of the release servers
or one of the development servers. If none of these are accessible from the machine (no internet access for example), the listed files will have to
be downloaded manually (see LISA Web 2.0 Update Repository).

Extension Updates

To download the updates of the Extensions,
Open the Web 2.0 browser within LISA.

® Click Help > Extensions Updates to open the following dialog:

E LISA Extensions Update = [ =[]

@ Download a new version of the LISA extensions for your domain.

Download Settings

Server [TKO download server -

Usemame iTHO-Contractor/gaur kullkkami

Password esssssssss

Version Oracle ADF bridge 0.5.7 -

Progress

Diownload ][ Cancel

® Click Download to start the download.
1.3.5 Browser Architecture

1.3.5 Web 2.0 Browser Architecture

The Web 2.0 architecture in 4.6 and newer versions is as below:


http://www.itko.com/download/release/lisa_browser/index.html

LISA LISA BROWSER (LEAN)

| LISA Stack (isajar, _misc jar, ele...) |

| Wl 2.0 Bridge [web20bridge jar) | See SHARED INSTAMNCE

jcbridge loads NET CLRin Java VW
(dbriclge jar, jdghue dl, dibridge di)

LISA BROWSER (LEAN)
| MET Prooty Client (isa_browser exe) |

Sea SHARHD INSTAMNCE

NET Fremating e

LISA BROWSER (SHARED INSTANCE)

LISA BROWSER (LEAN)

MET Proxy Server (isa_browser sxe)

Wieb 2.0 Recorder Wieb 2.0 Deougger [~ Ses SHARED INSTAMNCE
(lisa_birowser gxe) (isa_browser sxe)
Browes Functionally Platform Functionsity
(IE: Interop SHDacW w.oll, mehtml ol (Data structures: liza_lirowser XmiSerializers o,
Firefow: iza_browser exe, Editor: ScintilaMET o, Scilexer dl, TidyATL di,
Safari inberap Wiebiidiy Excet Microsoft. Office Imerop Excel.dl, Office dIf)

Applete bridgs layer (applet-manitor 4T}
Loads a JuM Up te 40 instances per maching.
Inslances can run in epecified usar accaunt

C usar account o current usar account.
Applets and HTTP capture

(appletcallback jar)

Mative Hooks for ActiveX, Flash, Flex and other pluging

Swing remate Injection NET remete injection
{=wingeallback jar) (injector ol dotriet-menitor o)
/
Swing | AWT / SWT Application WinForm Application Win32 Application
Beanshell NET Interpreter Loop
Record | Replay [ Script Execution Record / Replay / Script Execubion Global Hooks
(swingcalback jar, swl jar) (dotnet-collback dl)

Notes:

Q: Why is the browser hosted in .NET and native code rather than in TestManager (java)?

A: Hosting browsers in java correctly is difficult. There are a lot of products, open-source (jdic, jrex, etc...) and commercial that claim to do this but
our experience is that they are quite prone to crashing or freezing. Using a native environment (mostly) eliminates these problems.

In addition, even if this approach was more stable, we could not run java applets. The reason is that a JVM would host a browser, which would
then try to launch another JVM in the same process to run the applets. Since only one JVM per process is currently allowed, this would cause a
crash.

Q: Why is the communication mechanism between LISA and the browser .NET Remoting?

A: Given that we have a java process and a .NET process that need to communicate, we had a few options:

® In-process is not doable for the applets reason mentioned above, as well as the required ability to run browsers under different user



accounts.

® A proprietary protocol over raw sockets was too much work, especially since the communication must be bidirectional.

®* Web Services over HTTP is the approach used in 4.5 and earlier but it is slow, verbose and exhibits bugs in the Web Service stacks of
those platforms that undermine reliability.

®* The most elegant approaches are to either load a JVM in the .NET processes and use RMI, or load a .NET CLR in the JVM and use
.NET remoting. The first approach suffers from the applets limitation outlined above, which left us with the second one.

In 4.5 and earlier:

Will be completed upon request...
2. Recording Mode

2. Recording Mode

Within the Web 2.0 browser, you can record many type of applications like a simple web application, java application, swing application, .net
application to name a few. In the recording mode, you can test any website and record all the events in the browser. These recorded events can
later be replayed in the Playback mode.

sars) - Mode [ |
When you open the LISA Browser, by default it starts in the Recording mode

The LISA Browser has a toolbar as shown below:
I Mode O @ | @ 0 «@ gt - Address |hbtp:ffe.itko, comy v | - | Actions [ -0 - 38 - 10 @ . @ @I

On the left of the toolbar you can use the Mode button to select the Mode of operation within the browser:
®* Recording Mode - Where you can record the operation.
® Edit Mode - Where you can edit the transactions.
® Playback Mode - Where you can playback the recorded operation.
You can Record the web page in the Recording mode and playback the recording by clicking on the Playback mode.
You can view add/delete the Logical, Physical events and view the Object details in the Edit mode, which is described later.

To start Recording, select the appropriate option of recording from the Address bar drop down.

You can choose from -

Address -

% Mavigate

&2 Browsefor HTML
¥  Browse for Java
@b Browse for MET

4 Browse for Mative

Enter the website address in the Address bar.
You can navigate the website for testing and in the background it will record. Once done, click Save to save the recording.
This will save the recording and exit the web browser.

To playback or edit the events, open the web browser again. By default it will now open in the Edit mode, with the last saved recording.

For additional information see the topics below.

2.1 Recording Example

2.2 Recording a Swing Test

2.3 Recording an Applet Test

2.4 Different Views of a Web Page

2.1 Recording Example



2.1 Recording Example

To start the recording,

® Type in the some web address, say: http://www.itko.com/
® Browse through the web pages, so that they get recorded.

Its Web view will look like this:

I8 LISA Browser (4.7.5.0) (gourik) [Unnamed]
! File Edt  Commands Help
mdei P @ @Dk AdGess | Adions 5 -X-0 @ @0

(WER | oM | HTML

iTKOSBLISA™ ... . o

Request

TKID i & Dallas, Texas based company, serving global cusbomers. We |

testing and vrtualzation of madern applcations, enabing higher kevels +
4 »

Progess | 9 -

s DOM view will look like this:

{28 LISA Browser (4,7.5.0) (gourik) [Unnamed]

Adiress

WEB || DOM | HTML

= F HTML A |:_.'_|H
=« HEAD —
= = TITLE
exk Contact iTED: Offices, locations, ¢
o META
= META
= META
e LIMK
= LINK
< SCRIPT
e SCRIFT
1 SCRIFT
= SCRIFT
<+ SCRIPT
= SCRIFT
e LIME
= SCRIPT
=t // Preload Rolover Images if [«
= STYLE
=t Hnav, fnavul | paddng 0; m s
£ 3

Prigiess

Its HTML view will look like this:


http://www.itko.com/

B LISA Browser (4.7.5.0) {gourik]) [Unnamed]
5 Edt Commands Help
ivode M5 @ | o b0 4 Addess | Adions - -X- 0 @ 5 #©

mimu DHTML  XScript | Hml[]{http;ﬁwww.tk.n.:m v | % |.jrwmm|ﬂmmm !
1 =<IDOCTYPE himnl PUBLIC "-/AW3IC/DTD XHTML 1.0 Transitional//EN" "http /fwww w3.org/ TR <h &

2
3 <html>
4 <head>
5 <title>=Contact iTKO: Offices, locations, email, phone numbers= ftitle>
& <meta name="description” content="Locations, contact and sales information for US an
7 Zmeta name="keywords:" content="itko, lisa, inc., tko, interactive, contact, hg, headgu.
8 <meta http-equivs"Content-Type” content="taxt/html; charsetsiso-2859-1">
9 <link rel="icon" href="http:/fwww.itko.comfimages/itko.ico” type="image/ico">
10 <link rel="stylesheet” type="text/css" href="nttp:lawa itko com/dincludes/style css™>
11 ZsCript language="JavaScript” type="TEXTDavasScript" src="http ./ fwwiw itko comsincly
1z < fscript>
13 <script sro="http:/fwwe itko.com/includes/micFormaRL)s" type="text/javascrpt” langy
14 < Jscript>
15 wscript type="text/javascript” src="http:eww itko. com/fincludes/prototype js"=
16 < fscript=
17 Zscript type="textfjavascrpt” src="http:/fwww.itko.com/fincdudes/scnptaculous.js?load=
13 < fscript>
19 <script type="text/javascript” src="http:fwww.itko.com/fincludesdightwindow,js">
z0 <fscript>
21 <link rel="stylesheet” href="http /fwww itko.comdndudes/dightwindow.css™ type="text;
22 <script language="lavascript” type="text/Javascript">
23 /¢ Preload Rollover Images w
£ >

Pogress | 9-.:

Once you are satisfied with the recording,
® Click the Save button to save and close the LISA browser.

The test case of the recorded events, can be seen in the Model editor of the LISA workstation as shown below:

O|0] 6] o] &< %] a]a]s

The execution of this test can be triggered in the normal LISA ways, through:



® Staging a test or
® Using Interactive Test Run (ITR).

Reopen the LISA browser to view the recording in the Playback mode.

2.2 Recording a Swing Test

2.2 Recording a Swing Test case

To record a Swing test, you need to have a swing application.
® Open the LISA Browser and click on "Record or Edit a Java test case by clicking here"
® Click on "here" and browse to the path of the swing application.
® Open the Swing application and browse for recording.
° Swin tab will open in the LISA Browser as shown below:

(% LISA Browser (4.8.4.0) (gourik) [Unnamed]

! Fle Edit Commands  Help

i Mode [l # @ | @ B @ & - Address E--R-00 @& % & @

| SWING |

Welcome to the LISA UI Tester. Please choose from one of the follov

@ Record or edit 3 Web test case by typing the URL of the target we

@_J Record or edit a Java test case by clicking here.

@ Record or edit 3 Native test case by clicking here.

@J Or start with one of the previously visited targets below... [Cl

http:/iwww.google.com/ | Get Started : The Offi... JliTKO JIRA - Adminis...

A Swing example window will open as below:



DisabledMode TreeExample = E| [z|
Change Node

Enabled

Disahled

The Swing tab in the LISA Browser, will have the swing application example as shown below:

(% LISA Browser (4.8.4.0) (gourik) [Unnamed]
: Fle Edit Commands Help

E-a-3-0 @& « & ©

Swing Application |DisabladMods TreeExample L |g Refresh I

= %y DisabledMaodeTreek sample [DisabledMode TreeE xample)
= |:. javan. swing.J R ootPane
= |:I javean. gwing.JLaperedFPane [null layeredPane]
= |:I javan. zwing.Panel [null. contentPane]
= |:I javan. swing. ScrolFane
= |:. javan. swind.Jhiewpart
(I DizableddodeT reeExampled]
=[] DizabledModeTresf xample$ButtonPanel
{ iavax awing.JButtan [Enabled)
(B iavas.zwing.JButtan [Disabled)

Path w | b Inspect I
Progress [ i

2.3 Recording an Applet Test



2.3 Recording an Applet Test case
To record an Applet test, you need to have a web page which uses an Applet.
You also need to check the Applet related options in the Settings dialog box.

Enable Applets

- In the General Settings tab

Capture Applet zhapshots

- In the Recordings Settings tab

® Open the LISA Browser and click on "Record or Edit a Java test case by clicking here"

® Click on "here" and browse to the path of the web page which uses an Java Applet.
Example - http://csis.pace.edu/~bergin/Java/applets.htm

® Open the web page and start recording.

* A Applet tab will open in the LISA Browser as shown below:

a
8% LISA Browser (4.8.4.0]) (gourik) [Sample] Sample Applets

! File Edit Commands Help
Mnde O @ | @ 4@ gt Y Address |hitp v | (8 - Actions [ - (0 - 3 - 00 @ L @& @)
CWEE H DOM | HTML | APPLETS
.
The French Military Game
A Board Game that Learns
Welcame
4 2 ane| Resign| MNew Garne
W
< »
Pragress [ |Done P

® Click on the Applet tab -


http://csis.pace.edu/~bergin/Java/applets.htm

028 LISA Browser (4. 8.4.0) (zourik) [Sample] Sample Applets

! File Edit Commands Help

Path |

» | ﬂ; Inspect J

frogess [ ]

- w-

® Click Save to save the Recording. The browser closes upon saving.
® Open the LISA Workstation, where the recording appears as a test case and run it in ITR.



Eile Edit Wiew System Actions Help

bl & & ¢ © ® B8

Mew Open Sawve Start Test Start Suite Change Registry Toggle Registny CWS  Pathfinder Console

-

WSE Repors Stop)
= :i",—'_g‘Quick Start Sample e X
i) =
& v Interactve Test Run =
:MOHE %8 ¢ @d) s
l[ﬁ ¢ | Execution History
o 0) navigate (http:[{{{SERYERS}H(~berginfJavalapp &)
13 click, on BODY (Sample Applets )
» $ 21 mousedovwn an BODY (Sample Applets ) =
i - 31 navigate (htkp://{{SERVERS} H ~berqin/Javalapp
41 mousedown an BODY (Sample Applets ) B
B 51 mousedown on BODY (Sample Applets ) hatl
< 1l ] >
49| 4
: 3 >
] l 5| Run [Settings|

* When you play it in ITR, it will open the LISA Browser in the Playback Mode as shown below:



| (% LISA Browser (4.8.4.0) (gourik) [Sample] about:... |Z||E||E| |
: File Edit Commands Help
iMode B (7 [@] | @ D@ & Address @ @
Logical Events I B vieb |]'_¢.\| HTML" - .-’-‘-.ppletsll

@ ) navigate (hitp: A A{SER
1] click on BODY (S ampl
2] mougedown on BODY
@A 2| navigate (http:AH{SER
4] mougedown on BODY
8] mouzedown on BODY

E! end
S fail
E abort

You can also see the Applets on the LISA Website.



3% The iTKO LISA Soapbox: Cloud Application Virtualization, Validation & Quality: News Today: Enabli... [= |[B][X]
&8 Web | DOM | HTML | APPLET|

The iTKO LISA Soapbox: Cloud Application Virtualization,
Validation & Quality

Cloud, BPM, SOA & Enterprise Integration Validation and Virtualization, Software Quality, Testi
and IT Governance discussion mis_sives_, with iTKO Founder/Chief Geek John Michelsen and oth
iTKO executives. We invite you to participate in a quality discussion on this forum.

ITKO LINKS « Example: Dynamically Scaling Cloud ABOUT THIS
Performance Tests On Demand | Main BLOG

iTKO in the Mews
August 17, 2010 Blog Overview

News Today: Enabling the iTKOEBLISA
Defense Community in the

Cloud with LISA Virtual Subscribe in a reade
Dev & Testing I

£ >

iTKO White Papers and
Demaos

iTKO Twitter Feed

iTKO YouTube Channel

iTKD LISA - Website

| £

2.4 Different Views of a Web Page

2.4 Different Views of Recordings

When you record a test, it is sometimes desirable to understand how the HTML behind the page is organized. In particular, when you define
Filters and Assertions, you sometimes need to know something about an html attribute on the page, or some text that might be hidden, etc.

To facilitate this, the LISA Browser is capable to show different views of pages within the browser window.

To browse for a web (HTML) page or a Java applet, click the Address bar drop down and select the appropriate link as shown below.

Address |Elaai]#]s " | -

Mavigate

Browse For HTML
Browse For Java
Brovese For MET

Browse For Mative

= NS NN

Web View
For the purpose of illustration, we have taken the example of a online calculator as shown below:

This web page is using an applet and a plugin, hence these two tabs are seen.



LISA Browser (4.8.4.0) (Gauri) [Unnamed]

I File Edit Commands Help
Mode i}' gk | o @ @ 0 Address |http:J‘,l’richardbnwles.tripod.com,ijava;’ca\c‘htm v|f:_ﬂ - Actions E, v'__:'_' - x ~ [N |é ,;‘\ ] @

WEB [DOM || HTML || APPLETS || PLUGING

Share Thi

Build your own website on Tripod It'sfast, easy and economical.

VF':\dSA GGI'.'\onItEhs Training IS0 Bank of Baroda Home Loans Smart Card: Java Card
WET/JZEEVLEIEmb. Sys. /CATIA i /s e JCOF 21, 21, 41 Java Card 2.2.1
Neids/Ro Grester
"
A Simple Calculator )
2] 3]
4] 5] e
7] 8] 8]
ol J -]
el .
< | 3
Progress Jg- LS
DOM View

The DOM view is a hierarchical view of the web page HTML document currently rendered in the browser. When you select an element in the tree,
you can see all its attributes (name and value) displayed in the right hand-side grid.

Note that when you have a page made of frames, each frame node has its entire document available as child node so you can examine the whole
hierarchy at once.

The DOM view is the regular view of a browser as seen below: Here you can see the DOM tree of the above web page.

———

LISA Browser (4.8.4.0) (Gauri) [Unnamed]

: Fle Edit Commands Help

;Mnde{/“ & | & @@ g4 Address
WEE | DOM |HTML APPLETS || PLUGIMNS

= B HTML
-5 HEAD 1
<1: TITLE
=& STYLE
sxt  br.clearfloaticlearboth; height:1pe; display:block: width:1px} :focusiouting: 0 none} Float_left{float lefth div.th_n
=<5 BODY
<2 SCRIPT
<2 SCRIPT
<13 LINK
[=-<w» SCRIPT
&=k var cm_role = "live"; var cm_host = "tripod. lpoos.com''; var cm_taxid = “/memberembedded"'; var tripod_membe
<= SCRIPT
<2 SCRIPT
<1 SCRIPT
[=)--ex2 SCRIPT
exk  varlyoos_ad = Anay(); var lcos_search_guery ="'; var lycos_onload_timer; function lycos_check_size() {  +
%=t Casale Media 2007 [C]
#xt Ad Format: Pop Under
sxt Domain(z): lwcos.com
=)<z SCRIPT
gxt ol var casaleD =new Date[);var casaleR =[casaleD). gt Time[)% 8673806982 +h ath. random(); var casalel=esc.
<= SCRIPT
wxt Cazale Media 2007 [C]
< INPUT
<13 DIV
e DY b
45 | k4

Progress G-

HTML View

The HTML view is the textual source of the rendered page.
In addition, there are a few tabs at the top Show column, where you select the display.

The Frame combo box lets you select which frame to display the source of in case of multiple frames, and the HTML / DHTML / JScript buttons



lets you select respectively whether you're seeing the HTML that comes from the server (static HTML), or the HTML at it is currently being seen
by the client (Dynamic HTML), or the Javascript files and snippets used by the current page and frame.

This is especially useful when pages make use of javascript or ajax that dynamically modify the html in the browser without reloading a whole
page from the server.

Select Browse for HTML button from the Address bar drop down and enter the web page address. Here you can see the HTML view of the Java
animation web page.

The page below shows the html view of the above web page.

LISA Browser (4.8.4.0) (Gauri) [Unnamed]

: File Edit Commands Help

i Mode § o | ‘" Address | Actions [ - -3 - 00 & & @
WEB | DOM | HTML | APPLETS | PLUGINS
Show: DHTML  JScripk | Frame: |[]ihttp:ffrichardbowles tripod, comjjavalcalc.hitm) v | 1) « Tidy Gutput | () Shaw Errors B
1 <html> -
2 <head>

3 <title=< ftitle>

4 <style id="BANNERETTLE" type="text/css">

5 br.clearfloat{clear:both; height:1px; display:block; width:1px}
6 ‘focus{outline:0 none}

7 Sfloat_left{float: left}

g
9

div.tb_rmenu_bg, #tb_ad, a.hosted_by, a.build_button, a build_button span.btn_left, a.buwld_bL_ltton span.btn_right, div#share_section, div#search_ba

10 {background:url{/adm/ad/images/adbanner_sprite.jpa); font-family: Arial, Helvetica, sans-serif}

11

1z /% containers */

13 div#tb_container{background-position:bottarn; height:155px; averflow-x:hidden; text-align:center; }

14 div#tb_container div#tb_rmenu{background:url{fadm/adfimages/adbanner_sprite.jpg) no-repeat 953px 0; height:45px; margin:0 auto; width:955p:x;

15

16 div#tb_container div.tb_menu_bg{background-position:center -44%px; position:fixed; width:100%; z-index:2000}

17

1a A tripad logo & link */

19 div#tb_container div#tb_rmenu a.hosted_by{background-position:0 -1px; colar: #fff; display:block; float:left; fant-size:10px; height:41px; margin:0;

20

21 /* middle button area */

27 span.underline{rmargin-left: 7px; text-decoration:underline; cursor:pointer}

23

24 div#tb_rnenu div#switch div#build{float:left; height:41px; width:620px;position:relative;top:-44px]}

25

26 div#tb_rnenu a.build_buttan{background-pasition:0 -91px; color:#beccab; display:black; float:left; font-size:20px; font-weight:bald; height:d1ipx; lin

27 div#tb_rnenu a.build_buttan:hover{background-position:0 -136px; color: #292929%

Z2a div#tb_menu a.build_button span.sub_text{color: #fff; font-size:16px; font-weight:normal; margin:0 0 0 Z0px; cursor:pointer}

29 div#tb_rnenu a.build_buttan:hover span.sub_text{calor: #292929}

30 div#tb_menu a.build_button span.btr_right{background-position:-3px -46px; display:block; float:right; height:44px; width:25px} M
< b4

Progress :] Page size: 17KB J} v v

In HTML view, there are a couple of controls at the top of the window as shown below:

|5|‘IDW: HTML [ DHTML  JScripk | Frame: |[] ihttp:)frichardbowles. tripod. carmfjava/cale . hbm) A |n 4 Tidy Cutput C'Show Errars H

® Show HTML/DHTML/Jscript: You can select the required script from HTML/DHTML/Jscript. The Static/Dynamic HTML group lets you
select whether you're seeing the HTML that comes from the Server, or the HTML at it is currently being seen by the client. This is
especially useful when pages make use of JavaScript or Ajax that dynamically modify the html in the browser without reloading a whole
page from the Server.

Frame: The Frame drop down box lets you select which frame to display the source of in case of multiple frames
Find: The find button opens a Search dialog and allows you to search.

Tidy Output: Shows or hides the Tidy HTML output

Show Errors: Shows or hides the HTML errors.

Applet View

The APPLET view is a hierarchical view of (one of) the applet(s) currently displayed in the browser.

At the top of the panel, there is a combo box that allows you to select which applet to display the properties of in case there are several on the
page.

In the tree on the left is the component hierarchy of all the Ul elements that make up the applet. They are identified by class name and label or
text. On the right side is the property grid that displays all the names and values of the fields of the java object that backs up the selected Ul
component in the tree. Those are organized by java class hierarchy (e.g. java.awt.Component properties, javax.swing.JComponent properties,
etc...)

At the top of the panel, there is a drop down box that allows you to select which applet to display the properties of, in case there are several on
the page.

Here you can see the Applet view of the Java animation web page.
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@ java.awt Button [button10]
@ java.awt Button [button11]
@ java.awt Button [button12]
@ java.awt Button [button3]
@ java.awt Button [button4]
@ java.awt Button [button15]
@ java.awt Button [button1E]
@ java.awt Button [button17]
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Plugins View

The PLUGINS view is a hierarchical view of (one of) the Active X control(s) currently displayed in the browser.

In particular those can be FLASH or FLEX controls. At the top of the panel, there is a combo box that allows you to select which object to display
the properties of, in case there are several on the page. On the right side is a property grid that displays all the available information of a sub
control identifiable in the object.

For the Plugins, we have taken an example of a Flash animation.

When the flash animation invokes, you can see the plugins tab as shown below:
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Progress Q -

Swing View
The SWING view is identical to the APPLET view but represents the hierarchy of a recorded (or executed) Swing (or AWT) application.
In addition, selecting a node in the hierarchy will highlight the corresponding component in the Swing application.

The Swing view is a view of Swing operations. Here, we have running a swing application:
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.NET View

The .NET view is a view of .Net operations.

The .NET view is identical to the APPLET and SWING views but represents the hierarchy of a recorded (or executed) .NET WinForms
application. In addition, selecting a node in the hierarchy will highlight the corresponding control in the WinForms application.

In the tree on the left is the component hierarchy of all the Ul elements that make up the applet. They are identified by class name and label or

text. On the right side is the property grid that displays all the names and values of the fields of the java object that backs up the selected Ul
component in the tree.

2.5 Post Recording

2.5 Post Recording
Once the recording is done and you save the recording, the browser closes the window.
You can now see the recording as a LISA Test case in LISA Workstation.

For example, we record a few pages of a website. Once we save this recording, it will close the browser window and you can see the test case
formed in LISA workstation as shown below:

You can edit any of the test steps by double clicking on the test step in the LISA Workstation.

Select a particular step, to open its editor in the right panel:
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There are two tabs at the bottom in the right panel.

Web Event Info tab - Click on this to see the Web Event Information. Click on the "Edit Events Via Recorder" button to open the LISA browser for
editing as shown below:
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Response tab - Click on the Response tab to see the response as shown below:



%

Marne: |IZI) navigate (http: I ISERVERE M fawv ajrmenu htm) |

Think time: |0 milis v

Tai |0 milis v
U=e global filtars |:| Caujet
Execute on: ||-:u:a| |E]

Mext: | 11 rnousedowen on BODY (Build wour own FREE ... % |

abouk;blank.

< I | >
Done

Wiew | Source || Cni2i Tree|
= @

Web Event Info | Responze

Similarly, you can click on the Source and DOM tree tabs to see the respective outputs.
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Within the DOM tree view, you can select a Attribute and select a command to be applied to it as shown below:
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3. Playback Mode

3. Playback Mode

To execute or debug a Web 2.0 test, you will normally save it to LISA and execute it through Staging or in the ITR Interactive Test Run.

However the Web 2.0 browser also provides some facilities to do some quick runs and debugging of your tests. It is primarily designed to work
with Web 2.0 specific tests but has some powerful debugging capabilities.

A typical usage of this is right after a recording session, doing a playback to make sure everything goes as you expect. Once you have saved
the Recording, you can Replay the same using the Playback mode.

Click on the Playback button on the toolbar to view the details of the last recording.

During the playback, the browser toolbar is disabled.

This is the recording mode of a web page:
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on the toolbar as shown below:

The playback of the above recording is enabled by clicking on the playback mode button
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Options

The playback toolbar has a few different buttons than the recording mode, like
browser for playback from the options given options..

wherein you can select the

|

The Internet Explorer, Mozila Firefox, Safari buttons, k= & @ control which browser is being used to execute the web test. You can
select 1, 2 or 3 of them at a time. If more than one is selected, the selected browsers are used side-by-side. If none is selected, Internet Explorer
is used as the default (since it is automatically installed on Windows).




You can use the Move mouse button

Q

to turn on or off mouse movement during playback.

Playback Toolbar

The playback mode has a toolbar

Replay M M N ﬁ

4 B

movement of the playback activities.

Click on Execute Next or Execute all steps to run the playback as shown below:

Immn»ug

Execute
Mexd Execute

=]
Record
Fil=

at the bottom of the Logical events pane, to control the

Clean

All Steps

Re=set

Execute Next executes the selected event in the list.
Execute All executes all the events starting at the selected one.
Stop will stop the playback

The Logical Events are listed on the left side and the entire recording will be displayed on the right side.

Open Record File will open a previously recorded file.
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Once the playback starts, the steps that have run, are shown in green color in the Logical Events panel.

Tip: You can manually alter the flow by simply selecting an event in the list and clicking Next or Play. Alternatively, you can also press
<CTRL><E> to execute the next node, which is useful is mouse movement is turned on.

If something is not going as you expect during a long test, you can also press CTRL-C to stop execution.

Click on the HTML tab within the Playback mode,
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This will open a new menu bar as shown below:
Show: |HTML | DHTML  JScript | Frame: |[] (http:) e, itko, comfsuppr | i <4 Tidy Qutput @ Shiows Errors H

HTML - Click to view the html source
DHTML - Click to view the DHTML source
JScript - Click to view the Java Script source
Frame - Will display the frame name

Find - Will open a search window

Tidy Output - Will show the tidy output
Show Errors - Will open the error window

4. Edit Mode

4. Edit Mode

To open the Edit mode,

Mode l 5

In the Edit mode, you can view the Logical and Physical Events, Object Details and Response Panel.

Click the Edit mode option in the toolbar to open the browser in the Edit mode as shown below:

. Logical Events g ) ] ]
By default, the Logical events tab is open in the Edit mode.

Global Filters

Global Assertions

Q0|0

Datasets

[+

In addition to this, there are the following tabs in the Edit mode which can be expanded:

The main edit mode window is as seen below:
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In the left panel, a list of Logical Events is seen and on the right panel, you can see the Object details.

4.1 Event Types

4.2 Logical Events

4.3 Object Details

4.4 Filters

4.5 Assertions

4.6 Datasets

4.7 Editing Steps in Workstation

Please see the available subtopics for more information.

4.1 Event Types

4.1 Event Types

HTML pages can generate many different types of events and we're going to review them here to make it clearer when we talk about them in the

rest of the document.
There are several sources for Events:
Html page (DOM events),

Plugins (Applet events and others),

fail or end events).
There are two types of events:

® Physical Events
® Logical Events

Browser environment (Native events),

and finally actual events that are imported by LISA from steps that make use of other technologies or are used as markers (such as the




Physical Events - When we record or playback a Web 2.0 test, all the events occurring within or all actions taking place, are the physical events.

In the Web 2.0 browser, it is seen here -

Logical Events (2]

= @ 0] navigate [httpc A wivawy itko.camm,]

@ navigate [hitp: Afwasitko, com,]
@ docload [http: /e itko.comd

Filters
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Logical Events - However, from the user's point of view, only a small subset of these events is interesting and those are the logical events.

In the Web 2.0 browser, it is seen here -
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For example, clicking on an html link could result in a mouse down, focus, mouse up and click events (Physical events), but the user sees this as
only a click event (Logical Events).

LISA will actually group these physical events together into an event bucket and mark the click as the bucket's logical event.
DOM Events

Icon Event Description

@ Navigate the user navigates to a page by using the address bar or the navigation buttons

il Doc Load = a html page or frame is loaded as a result of a user action

KeyPress the user presses a key

Change a DOM element's value is changed (inputs, selects or text areas are subject to this for example)
Focus a DOM element receives the focus in a page or frame

Click a DOM element is clicked

Double Click ' a DOM element is double-clicked

Mouse Down | the user presses a mouse button

B EEEEE



Mouse Up the user releases a mouse button

Mouse Over | the mouse hovers over a DOM element area
Mouse Out  the mouse leaves a DOM element area

Applet Events

Icon  Event Description

Q Applet Load a new applet is loaded by a Doc Load

Q Asynchronous Change  the applet hierarchy or visibility changed as the result of a user action

Q Focus an AWT or Swing component receives the focus

Q Click an AWT or Swing component is clicked

Q Double Click an AWT or Swing component is double-clicked

Q Change an AWT or Swing component's value is changed (text fields or com boxes are subject to this for ex.)
Q Mouse Down the user presses a mouse button

Q Action AWT/Swing's notion of an action event

Q KeyPress the user presses a key

Swing Events

Icon Event Description

§| Applet Load a new applet is loaded by a Doc Load

I:I Asynchronous Change ' the applet hierarchy or visibility changed as the result of a user action

I:I Focus an AWT or Swing component receives the focus

I:I Click an AWT or Swing component is clicked

I:I Double Click an AWT or Swing component is double-clicked

EI Change an AWT or Swing component's value is changed (text fields or com boxes are subject to this for ex.)
I:I Mouse Down the user presses a mouse button




I:I Action AWT/Swing's notion of an action event

D KeyPress the user presses a key

Native Events

Icon Event Description
Open a new browser window is opened
Close a browser window is closed
Alert a JavaScript alert dialog is clicked by the user
Confirm a JavaScript confirm dialog is clicked by the user

File Dialog = a native File Open or File Save dialog is clicked by the user

External Events

Icon Event Description

@ Continue = a no-op event
@ End marks a test end
@ Fail marks a test failure

@ Any other non-Web 2.0 event imported from a LISA step

.NET Events:

Each event has many properties attached to it that describe all the information necessary to replay it. We will go into those properties in detail in
the next section, as we discuss how to modify these events after a recording.

4.2 Logical Events

4.2 Logical Events

Once a recording is complete, a LISA test can be generated instantly by saving the recording as-is in the Browser window. You can then replay
the recording in the Playback mode by reopening the browser window.

However, there are several reasons why it might be desirable to inspect or modify events before committing them to a Test Case, or to edit
them on an existing Test Case.

This is the purpose of the Logical Events tab in the browser.

In the Editing mode, you are able to view the logical and physical events of the test case. The Logical Events window in an Editing mode is as
seen below:
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Logical Events Panel

This is on the left of the Browser window. In the Logical Events panel, you can see the list of events recorded so far. The logical events panel is
as shown below:

Logical Events (2] ]
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To view the Physical events (mouse clicks etc), expand the event by clicking on the "+" sign.

Each of these events is expandable so you can inspect all the physical events in its bucket, all the Filters and all the Assertions attached to that



event as shown below:

9] click on INPUT wpe=submit [
8% Physical Events

Filtkers
A Azzertions

You will also see tabs for Global Filters, Assertions and Data Sets at the bottom.

Global Filters O
Global Assertions O
Datasets ﬁ

Add/Modify/Delete Events

At the bottom, there is a toolbar which allow you to Add/Delete/Modify an Event/Filter/Assertion depending on what you select.

(+})u] (s

Button = Action Description
Add an event If a top-level event is selected, a new logical event will be added, otherwise a physical event will be
[El added
El Remove an event External events can not be removed from the browser, you have to do it in LISA itself
= Save an event All the changes made to an event in the detail pane (on the right side) are committed
Move an event up in the list Use with caution on physical events as results are sometimes hard to predict
Move an event down in the Use with caution on physical events as results are sometimes hard to predict
list

In addition to the icons at the bottom of the screen, you can also manipulate events, Filters and Assertions in the left panel:

® Right-click the Step in the Logical Events column to open the screen below which helps to Copy/Paste, Add and Delete an Event

Logical Events (7] ]
=@ 0 navigate ()
=@
add Event
Fil

A A3
@A na
2] key
B 3)key
& 4] clic Show all Filkers and Assertions
B 5] Cl!': Hide all Filkers and Assertions
8 E)clic
% 7 clie Showe all Physical Events
2 clic i )
@ 9 na Hide all Physical Events
8% 10] click on A [Cem Kaner)
ﬁ abaort

Similarly, you can right click on any filter or assertion to add or delete the same. You can also Physically drag and drop a step from one location to



another.

Configurations

A Configuration is a LISA element that provides a set of properties containing information about the environment or 'system under test'.
Configurations can be de-coupled from the Test Case to obtain maximum portability. For detailed information on Configurations, see Using

Configurations.

4.3 Object Details

4.3 Object Details

In the Edit mode, you can also see the Object Details Panel. All the details regarding the selected object are listed in this panel.

This panel changes according to the item selected in the left panel.

If you select the Logical events tab, its object details will be seen.

If you select the Global Filters/Assertions/Dataset tabs, their respective editors will be seen.

® Double click on an object in the Logical Event panel to open the Object Details as shown below:

Object Details

Browserld
FrameF ath

Key
b odifiers

Thirk.
Type
*

iy

Ll
Walue
#Path

E User Doc

Browserld

event ocoured in

=2 NE@ 7

E Base Property

1]

i
haone

15
click
18

4

E DOM Property

hittp: AH{SERVER I
Cem Kaner

FHTHML/BODY /P[]

The index of the browser window this

Screen | Source | Docs || Traffic

testing.com > Testing Craft = Techniques (Test Project
Planning) > Kaner's Collaborative Planning

Search

Collaborative Test Project Planning in the

Style of [Kaner96]

Created and summarized by Brian Marick.

The article in question is by : titled "Wegotiating Testing Resources:
A Collaborative Approach”, which is in the Proceedings of Quality Week 1996

From the article:

"My objective is to facilitate a corporate consensus on testing tasks, priorities,
and titmes. That is, [ want to end up with:

+ a bottom-up task list of every test-related task or area to be tested that
requires a day or more of testing; v

Path | HTML/BODYAP[21A[1] Highiight | | Use Text

This panel is again divided into two parts: Left and Right

In the left part, all the properties specific to an object are seen.

It is divided in 2 sections:

1. General properties (common to all types of objects),
2. Object-Specific properties (i.e. DOM/Applet or Native Properties etc.)

The right part shows the response of the selected object and can be seen only if it is enabled from the icon.

Let's go over each of these in detail.

Object Details panel



Object Details
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At the top of the Object Details panel, there are buttons which can rearrange the data as required:

Hz- | A
D A

N0

Each icon has can be clicked or un-clicked to show or hide data.

DES

k=2

Click to get a categorized view of the data

A
Click to sort the data alphabetically L‘L

Click to show/hide response pane

Click to show/hide hierarchy

Click to show/hide Invisible elements @
fird
¥

Click to enable/disable scripts

The Base property tab is made up of the following:

Browser ID: The index of the browser window this event occurred in

Frame Path: The path to the frame this event occurred in

Guid: The unique event identifier

Key: The keyboard key associated with this event

Modifiers: The mouse or keyboard identifiers in use when this event occurred
Request: The request data associated with this event

Response: The source of the container at the time of this event

Think: The think time of this event

Type: The type of this event

X: The X component of this event relative to its event



® Y: The Y component of this event relative to its event
The DOM property tab is made up of the following:

® Sub tag: The html type attribute of the target element

® Tag: The html tag of the target element

® URL: The URL of the browser in which the event happened. For Ajax events the URL shown is not the URL shown in the browser, but
the URL available to the Server to handle the Ajax calls.

® Value: the Value of the DOM element after the event fired, if it makes sense in this context.

® XPath: the XPath expression that uniquely identifies the DOM element that was the target of the event.

The Native properties are made up of the following:

Button: the label of the button the user used to dismiss the native dialog (such as Open, Save, OK, Cancel, etc.)
Selection: an optional selection value that some dialogs offer (such as a filename)

Username: currently not used

Password: currently not used

The Applet properties are made up of the following:
® Applet: the class name of the applet that received the event
® Path: the xpath-like expression that uniquely identifies the AWT or Swing component that was the target of the event

® Class: the class name of the target component
® Text: the text or label of the component after the event was fired

Response Panel

Finally, the Response panel contains the state of the page after the event was fired.

In the case of a DOM event, that translates to an HTML source, in the case of an Applet event, it is an Applet hierarchy. As of now, responses are
empty for Native Events.

Sereen | Source | Docs | Traffic
.S
testing.com = [esting Craft > Techniques (Test Project Search
Planning) > Kaner's Collaborative Planning -
Collaborative Test Project Planning in the
Style of [Kaner96]
Created and summarized by Brian Marick
The article in question is by : titled "Wegotiating Testing Resources:
A Collaborative Approach”, which is in the Proceedings of Quality Week 1996.
From the article:
"My objective is to facilitate a corporate consensus on testing tasks, priorities,
and times. That is, [ want to end up with:
» a bottom-up task list of every test-related task or area to be tested that
requites a day or more of testing; w
th | HTML/BODY/P2JA[T] | Highiight | | Use Test

It has four tabs -
Screen - This shows the actual html page

Source - This shows the html source of the page



Docs - Will show the docs if any

Traffic - This shows the Request and Response headers for the html page.

For an Ajax request the Response shows the resulting document that gets loaded.

When you decide to edit an event after a recording is complete, some of the fields are hard to fill correctly, notably the Path or XPath fields.

To assist you, there are some Browse Buttons available next to those fields. When you click them, it will bring up a mode dialog window that
contains a browser and helps you select those paths.

Below are pictures of these browsers in the case of a DOM event and of an Applet event.
These DOM and Applet browsers have 3 main sections:

® An editable combo box at the top that contains an XPath expression along with a Select and Cancel buttons

® A tree view on the left along with a property grid underneath it

® An actual browser that renders an HMTL page or a snapshot of the applet.
You can browse the page or applet by clicking either in the browser or the tree and they will automatically synchronize with each other and the
XPath combo box. Typically you would click an element in the browser to generate its xpath, unless it's a hidden element, in which case the tree
view is appropriate. When you click an element, either in the tree or the browser, it gets highlighted so you can be certain it is what you think it is.
When you are satisfied with the element you chose, you can click the Select button and the Xpath will be transferred to the field that offers the
Browse. If you change you mind, Cancel will discard the browser without any changes.

Note that this browser disables all JavaScript or dynamic behavior and can be accessed offline. However it still goes to the Server for css and
images if the cache is empty on your disk.

4.4 Filters

4.4 Applying Filters

Authoring or executing a test, steps or events are only half of the equation in LISA.

You need to be able to parameterize inputs and outputs to make the test generic and be able to assert on the results to decide what constitutes
success and what constitutes failure.

Filters address the first of these points.

In the context of Web 2.0 tests, you can think of Filters as functions that execute after an event and store the result in a variable that can then
later be accessed by other events, Filters or Assertions.

You can inspect, add, remove, or edit Filters in Edit mode of the browser.

These Filters are listed in the Logical Events section. You can see them once you expand the Object tree.

Event Filter

To add an Event Filter

® Select any logical event and click to expand the tree.
® Right click on the Filter node and select Add Filter option as shown below:

FrTTre=TTT

=
u:I-:u:Iu:uau:I [http .-".-"{{SEFE"»-"E

ﬁ % F'.u:h:l Filter

1 Az

Show all Filkers and Assertions

Hide all Filkers and Assertions

Shows all Physical Events
Hide all Physical Events




The filter editor will open in the right panel as shown below:

Object Details

D efintion
@ A filter iz a function that executes before or after an event iz tiggered and stores its result [Filter Value) in a variable [Filter Key].

Fiter Key fiter. click. 4080903 3

[ wiait up to ms for value

Froperties
@ A, et filker retrieves the inner text of a DOM element uzing a regular expression [first capturing group).

) DOM Element | //DIV[@id="similarbooks_v' A1 /IMG v
@) Text [ v
O DOM Attribute

) Seript

() Expression

() Cache

() Capture

) Import

() Hardware

() Code

) File

() Datazet

() Browser

) Sleep ms

() Secure Prompt

Quick Test
@ Click Evaluate to see what value this filter would retum if it were evaluated during the recording.

The Filter object details pane has all the information required to set up a new filter or edit an old one.
After the definition of the Filter, you can see the following:
Filter Key: The key is the name of the variable that is going to receive the Filter result after it executes.

® Or Click on the *Browse* button to open a *Property Browser* as shown.
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® Click Select to add.

Filter Properties: the following types are available. Clicking on any of the Filter properties will give its description.
DOM Element:A DOM element Filter extracts an HTML element object from its event's DOM

Text: A text Filter extracts a piece of text from its event's response

DOM Attribute: A DOM attribute Filter extracts an attribute value from its event's response

JavaScript:A JavaScript Filter executes arbitrary JavaScript code in the context of its event's response
Expression: An expression Filter allows you to combine other Filters

Cache: A cache Filter clears the specified browser cache

Capture: A capture Filter saves the current response to the specified location

Import:The import Filter makes the specified file (js or java) available as a library to the running application
Hardware: A hardware Filter executes the selected mouse or keyboard action on the specified desktop

Code: A code Filter executes arbitory. Net code that has access to all the LISA browser variables

File: A file Filter allows you to execute a variety of operations on file, local or remote

Data Set: A Data Set Filter automatically extracts data out of the specified element into a Data Set according to row and column path rules
Browser: A browser more Filter toggles the state if the playback window to use the selected browsers

Sleep: A sleep Filter sleeps for a specified amount of time

Secure Prompt: A secure prompt Filter lets you fill in some variable at runtime if you do not want them persisted

Quick Test:
Click to evaluate to see what value this filter will return.
Evaluate: Click on Evaluate to evaluate the filter. The Filter runs with the response it got during recording and displays its result in the "Recorded

Value" field as shown below:
Guick Test

'@' Click Evaluate to see what value this filker would return if it were evaluated during the recording.

Recorded W alue ITEO LISA - Wirtualization, Testing and Y alidation Software for ..

[ Evaluate |[ Clear &l

Global Filter

To add a global filter,

Global Filters O

® Click on the Global Filter button at the bottom of the Logical Events pane.

® Click the Add button to add a global filter.
This will open the same filter editor as for event filter.

® Enter the appropriate criterion so that the filter is applied to all the events.

Example

Let's say the page has (and should have) the text "Welcome John" inside some div after a certain DOM event. To extract the value "John" and put
it in a variable for later use, you should pick a Text Filter, and a regular expression like "Hello (\w+)". The first capturing group in the regular
expression will be used to find John in the page. If you want to be even more specific, or you think there could be more than one match in the
page, you could browse for the div that should contain this text and use it as the DOM element.

If you wanted to put the document's title into a variable, you could use a JavaScript Filter with the code: "document.title". If you needed to put the
number of rows in a certain table, some JavaScript code like "document.getElementByld('mytable’).rows.length" would be appropriate.

Let's now say you had 2 tables whose number of rows should always add up to the same value. You could add 2 Filters like the previous one (say
"f 1" and "f 2"), and add another Composite Filter "f 3" whose value is "f 1 + f 2" and us

Once you add some Filters, the resulting variables are available to use almost anywhere else, and the combo boxes for editable fields will then
contain those variables.

Finally, there are some intrinsic Filters that are not displayed in the list because they are not editable.
They populate a set of "well-known" variables after each step:

event . t ype: The last event type

event . pat h: The last event path

event . r esponse: The last event response

event . raw. r esponse: The last event raw response
{event . url : The last event URL.

Note: The distinction between response and raw response is that responses may be computed from raw responses and other factors such as
previous event responses. In particular most events generate only a raw response that is a diff between various DOM states. The response just



rebuilds the current DOM based on a previous DOM by applying successive diffs.

4.5 Assertions

4.5 Applying Assertions

Assertions are also functions that execute after an event is fired, and return a Boolean value. If the return value is true, the test proceeds
normally, otherwise what happens depends on the Assertion itself. It is a typical if-then-else scenario.

Practically speaking, you can inspect, add, remove or edit Assertions in the Events tab of the browser.

Event Assertion

To add an Event Assertion,

® Click on any logical event to expand the tree.
® Right click the Assertion node and select Add Assertion as shown below:

Logical Events gl Object Details
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Hide all Physical Events

The Assertion Editor will open in the right "Object Details" pane as shown below:
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On the Assertion object details pane, after a quick description of the Assertion type that is selected, you can see the following controls.

You need to select two parameters, which are to be compared.

IF - Select the event which you want to compare in the forst drop down and select the event, with which you want to compare, in the second drop
down.

Select the *type of operation* to be applied in the middle drop down.

Type of operations are -

Equals: those compare the 2 sides of the expression for equality

Not Equals: those compare the 2 sides of the expression for non-equality

Matches: those attempt to match (as regular expression) the left or the right side of the expression against the other side

Not Matches: those attempt not to match (as regular expression) the left or the right side of the expression against the other side

Less Than: those compare the 2 sides of the expression as numeric values for order. Returns false on non-numeric values
More Than: those compare the 2 sides of the expression as numeric values for order. Returns false on non-numeric values

THEN -- Select the step to execute if the expression is TRUE/FALSE

The main point in an Assertion is its expression.
It is this, that determines the success or failure of a test so it is important to be careful in constructing this expression.

There are several types of built-in expressions.

Quick Test

Click to evaluate to see what this expression will do if it was evaluated during the recording session (TRUE if it would fire, FALSE otherwise).

Typically, you will use a variable created by a Filter on the left side and then equal it or match it to a constant value or another variable on the right
side. In more advanced cases you can use JavaScript expressions to assert on arbitrary conditions.

Evaluate: Click to evaluate.

Global Assertion



To add a global Assertion,

Global Assertions (2] ]

® Click on the Global Assertion

® Click the Add button on the toolbar to add an Assertion.

This will open a editor similar to the Event Assertion.

button at the bottom of the Logical events panel.

® Enter the required details to run the assertion on every event.

4.6 Datasets

4.6 Applying Datasets

Datasets can only be applied globally, i.e to the entire test cycle.

To add a global dataset,

Datasets 9

s |. :I
® Click on the Datasets button IEI lEl =5 8

® Click the Add button to add a dataset.

This will open the dataset editor in the right "Object Details"

% LISA Browser, (4.8.4.0) (gourik) [Unnamed]

located at the bottom of the Logical events pane.

pane as shown below:

17.4.4 Assertions - LISA
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Define the dataset in the dataset editor.

Name - Enter the appropriate name or accept the default provided by LIS

Data Source - Select the source of the dataset - either from a spreadsheet or from a database.
Spreadsheet - Select this to attach an excel sheet as data input.

® Enter the name of the excel file or browse and select the file.

Database - Select this to select the data source from a database. It will further open the type of databases to choose data from:



Select one from the Oracle database, SQL database or ODBC database.
Enter all the details related to the database.

Enter the SQL query

Click Evaluate to evaluate the results.

e o o o

4.7 Editing Steps in Workstation

4.7 Viewing and Editing the Test steps

One of the major strengths of LISA is its outstanding ability to create and run tests that make use of a mix of different technologies (web, j2ee,
web services, swing, etc.) as is so often necessary in the enterprise software world.

Web 2.0 tests are no exceptions in this regard and can be mixed with any other type of step. Nothing special is required to achieve this.
To Add steps to an existing test case,

® Open an Exiting test case and then start the web 2.0 recording.

® Once done, Save the recording. This will close the web browser.

® This will add all the recorded steps to the already existing test case in the model editor.
To Edit/Add/Delete Web 2.0 steps,

This can be done by requesting a detailed view of existing steps.

® Double click the step in the Model editor for which you need a detailed view.
This will launch the editor of the respective test case.

For example, we have chosen to view the detailed view of the HTML type of test step and hence it has opened a HTTP/HTML Request editor as
seen below:
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| URL Transaction Info | HTTP Headers || Responsa |

You can also view the response of the Web 2.0 steps exactly the same way you were doing it with regular web steps, by selecting the Response
Tab in the step's detail pane.



@ Quick Start sample X

Project

BT =5
@ A virtualization and Yalidation Software for Modern Applications: SO, Cloud, BPM & Testing Optimizationl
~

Feeling Cc

Constrained by unavailable
developing and testing? LIS
constraints by rapidly £

|

: | 2
E Dane
View | Source || alely] Tree|
Select & Command v
A -
AsserRd o | URL Transaction Infa || HTTP Headers | Response |
For HTML pages, these responses come in 3 flavors:
® as Headers
® as XML source
® asaDOM tree
Image below shows the DOM tree response:
i
= @ Quick Start sample i X
£ d BT =
g akion &
@ A
[=-4B# HEAD b
- @--q: TITLE
’ ITKO - LISA Virtualization and} i o t% iTKO - LISA Virtualization and Walidation Software For Modern Applications: S04, Cloud
[=-<E3 META

- & content="504 Yalidation & Virtualization with iTKO LISA software inteqgration lifecycle o
- & name="description"

=483 META

A conkent="itka,s0a testing,quality assurance, virtualization, virtual services,qa, test, kool
& name="keywords"

[=}-4Bx META

- & content="text/html; charset=iso-8559-1"

i A hbbp-gquiv="Content-Type"

[=-<E3 LINK

e B href="images/itko.ico"

- & rel="icon"

- & bype="image/ica"

[=}-4E= LINE

- & href="includesjstyle, css"

- & rel="stylesheet"

- (2] >

Wiew || Source | DOM Tree

Select a Command W

@ Assertss Ea

[I£3

4 fesartRd

~

T +{| URL Transaction Info || HTTP Headers | Response I |

5. Debugging

5. Debugging

You may need debugging, If you want to debug a code or see the problem area.

Instead of clicking Next repeatedly for every step, you can set one or more breakpoints in the events list and click Play or Replay. Once you have
reached the events of interest, you can step through one by one.



If something is not going as you expect during a long test, you can also press CTRL-C to stop execution.

Debugging within Browser

=

In the top toolbar, there is a Show/Hide Debug Window icon.
Click to open a debug window at the bottom with a set of tabs.

We have opened the debug window in the Recording mode as below:

[1#% LISA Browser (4.8.4.0) (Gauri) [Unnamed]

: Fle Edit Commands Help

iMode (Bl @ | @ 0 @ g 4~ Address |http:,|’)’www.|tko.com,l’serwces,l’lndex.]sp v|@ - | Actions [E ~ 20 - 3¢ - (D |I€|)’f{ @ @
WEB | DOM | HTHL|

-
contact us | support | sitemap blog.itko.com Custom Sear 2

iTKOGILISA

iTKO Services e

TKO Elog

TKO In The News
& KO Whitepapers
&l Upcoming Events

home  products = solutions [EEWISN —company | partners | resources

Request an Evaluation »)

I
iTKO Professional Services Organization v
< il b
Qutput | Immediate |
| Time Type  Meszage L]
07.50:20.281 @ Received DOM Event: [BID: O[FPATH: [TYPE: mouseover[PATH: AAUL[@id="nav'[/LI[2]AULALITJAA]LOC: 4, SITHIMK: 32][URL: http: /v itko.com/servicesdindes. ).
07:50:20 56 O Received DOM Event: [BID: D[FPATH: [TYPE: mouseover[PATH: AAUL[@id="nav'[/LI[2]/UL/LINTJILOC: 4, BJ[THINK: 378][URL: http: / Avnen itko.comd servicesfindex =.
0750:28640 é Connectivity to http:/ A itko. comdservices/index. jsp: True
083:19:47 453 G Received DOM Event: [BID: OFFATH: [[TYPE: focuzgin][PATH: /HTML/BODYILOC: 0, OITHIME: 1766453 [URL: http:/ A itko. com/zervicesindex. jspl[TAG: BODY).. ]
Progress | | 18 logical events (61 physical events) oW~

The Output tab logs information about execution and potential errors or warnings.

When you double click an error/message in the debug window, information about the same is seen.



! File FEdt Commands  Help
i Mode iﬁ Q | @ ? g Ls ‘i~ Address ‘http:f,l’www.itko.com,l’companyfindex.jsp v|@ - | Actions E,
WEB | DOM | HTML|

]
I contact us | support
- LT : M
’ KO % t {¥% Information {4.8.4.0) (Gauri)
I Message

i

i .

I

|

|

partners resources

Message Details
Detals Quick Links

Received DOM Event: [BID: DJ[FPATH: J[TYPE: mouseover][PATH: #/MG[Eid="company'[[[LOC: 10, 20]
[THINK: 1963]JURL: hitp: /v itk o com/company/indes ispl TAG: LITSUBTAG: TMALUE: |

& KO Blog

& KO In The News
& KO Whitepapers
& Upcoming Events

)
] >

|

Cloze

Time Type  Message A
08:47:589.265 () Received DOM Event [BID: OFPATH: //FRAME [@Ename=lightwindow_navigation_shim[[TYPE: doclaad][PATH: JILOC: O, 0][THINK: S4]JURL: javascript:false:][TAG: IL..
08:47.59.265 e Document Complete for: javascriptfalze; [//FRAME[Ename="i

Output | Immediate |

htwindow_navigation_shim'])

Progress Done [

The Immediate tab lets you execute arbitrary JavaScript functions (including using variables).

It is used at design time to debug and evaluate expressions, execute statements, print variable values etc.

We have opened the debug window in the playback mode as below:

LISA Browser (4.8.4.0) (Gauri) [Unnamed] Google

i Fle Edit Commands Help
i Mode i 5 | @ @ @ gt Address httpfeegoogls co.inf v | | Options & @ Q
Logical Events g ‘weh
@ 01 navigate [Kttp /v, goodle. co.ir ||| show: DHTML  JScript | Frame: |[] (htkpef v, google. couing} - | | &% ‘ - Tidy Qutput |® Shaw Errors !
& 1) ick on TD 1 <IDOCTTPE htmi= ~
2] keypress [[] 2 i
8 2 click on IMNPUT type=text [Google 3 <html onmousemove="googleamp;&amp;google fadeamp;&amp;google fade(event)"= )
B 4) change on INFUT tpe=test fitka 4 <head> .
o P 5 <meta http-equiv="x-UA-Compatible" content="IE=&">
[ <meta http-equiv="content-type" content="text/html; charset=UTF-8">
7
r " . 5] <titlexGoogle< ftitle>
7] click on & [Peformance Testing) a Zscript type="text/javascript's
8] mousedown on HTML (Pertarman 10 window.google={kEl:"EudtTMCeBcOSrafrhNzx Cw" KEXPI;"17259,26000" kCST {e:"17259,26090",&i: "EudtT
G 9] navigate (Back) 11 window.google sn="webhp";window.qooale timers={load: {t: {start:(new Date).getTime()}}};try{window.ac
" P 1z < fscript=
10 clck on & [we.tko.com] | 13 <style id="gstyle" type="text/css">
11} mauseaver on IMG (http:/fwww.i 14 body{margin:0}#gog{padding: 3px 10px 0}d{line-height: Sem’}.qac_m td{line-height:17px Harm{margin-l
& 12] click on MG [http: A vva itk o.co 15 < fstyle=
B 13) click on IMG (htp: /wew.itko. 18 <style type="text/css">
(?3 M]CIC o [L\D wipliko.cog= 17 #fctr, #ghead,#prnocntr,#sbl, #tha,#the, fade, . gbh{opacity 1;filter:alphafopacity=100)}
| mouseaver on 1 istylex
g}abort 2 19 <style type="text/css">
ETA. . — 20 .pmoabs{pasition:absalute;right:0;top:25px; b .pmoflt,.prmoc{float:right; clear:bath; } #prmocntrz {behavior:ur
< | 2 21 < fstyle> v
Replay M B = B B¢ 0 .
Output | Wariables | Immediate |
Time Tup Message L]
075225437 ) Could nat find element //DIV[@id="badyContent' PUL[TILIZE /. after S00ms
075325437 @ Executing DOMEvent: [BID: DFPATH: JTYPE: click [PATH: #/DIV[@id="badyCortent' UL 1ALI/B AA][LOC: 102, 12)[THINK: OJURL: http: /en wikipedia, orgAwikiiteo][T
075325437 @ Evecuting DOMEvent [BID: OJFPATH: JTYPE: docloadPATH: [ILOC: 0, OITHINK: SO0BIIURL: http:#/er wikipedia ora/wiki/Performance_T esting] TAG: [SUBTAG: WAL
075325 625 O [Bucket Duration: 3750 ms]
075320640 @ Consecutive wamings exceeded threshold [2] ]
Progress http: f v google. co.infimghp?hl=ent ab=wi

These tabs are same as in the Recording/Edit mode - with an addition of one Variable tab.

The Variables tab shows you all the variable names and values at the current step (the ones highlighted in red are the ones that were potentially
modified by the last event)

As a further debugging mechanism, there is an HTML tab at the top that allows you to see the dynamic HTML source of the current page.

The Split toggle also applies in this source view for further comparison.



Multiple Browsers

When multiple browsers are selected you get the logging information for each of them as shown below:

Outpidt | anables | bmenediate

Tirme ez age -
192326 Executing DOME vent: [BID: OJFFATH: ||[TYPE: dochadlPATH: JLOC: 0, OFTHIMNE: 141 PURL: hip/ fessve. google com zaarchhi=enk...
192326 [Bucksat Duration: 953 mz)

_.
&3

132326 G |IE FILTER:|T et filer. chck BE7SE40T e chck BE7EEA0=5each]
132326 G FF FILTER:[Test: fiten . chick. EATREA0][Alen. click BETSEA0=5aa1ch)]
L
Progress | |

Filters also get executed for each browser and the browser abbreviation is appended to the filter key so they can be referenced individually, as
shown below:

Output | Vanables | Immediate

Key Wae -~

{{event responss}} tHTML:<HEAD> < TITLE ritko - Google Seach< /TITLE» <META, hitp-aquiv=conbent-tppes cont

{levent shatus codel} 200

{{event typei docload

{{ewvent wil} Ftp: /v, ooogle. comdseanch hi=enka=itkotbinG =Google+Seach

[Elilim chick BBTSE40 Iﬂ;]I Search -
>

Script execution is also performed for each selected browser as shown below:

Output || Variatles  Immediste

refum document all length; -
IE>423

FF=418

documest tkle
|E> itk - Google Saarch

FF>itko - Google Search w

Opening a System Debugger

To open a system debugger,

Click on the Enable Script Debugger button at the bottom of the window:

[B® Enable Script Debugger
T4

.I/v1

This will open a script debugger if present in the system.
6. Setting up ADF Extensions

6. Setting ADF Extensions

To set up the ADF extensions in the LISA Browser, the browser needs to updated with the extensions.
To update the extensions,

Open the LISA Browser.

Click on the Lisa browser -> Help menu -> Extensions Update.

To update the settings,

Open the LISA Browser.

Click the LISA Browser > Edit menu > Browser settings.

This will open the browser settings window.

Click on the Recording Tab as shown below:



=
i Settings

General | Recording | Playback | Environment

Recording Strategy Recording Options

All . )
|ze contest menus for filkers and assertions

[] “white Traffic to Disk
Compress recording files

Ignore ids and names whoze value matches:

Euternalize recorded text
Capture Level
DOM
[] Capture DOM Level 2
Ignare frame names whose value matches: i
[] werboze HTML recording
[] lgnore HTML responses
[grore text whoze value matches: [ Capture HTML changes

[ Capture &pplet snapshots
IJze the following attnbutes [in thiz order]: ]
[ Capture &ctivel snapshots

1] ]
Capture Diff Size Buytez
2] ]
Capture Max Time me
3] 7]
Capture DOM Events
4] ]
havigate docload
Or uze the following locator javascnpt function f dblclick
0CuE clic
% w
. mouzedown change
I invizsible el t
ghore invizible elements —— R
Jara MOUSEOVET drag/drop
Fecord using: [ mouseout MOLEEMOYE
[ ] Component names Deep paths click keypress
Camponent text Geometry open/cloze [ ajax calback

@ Faor help click an the 7 icon in the top-right cormer, then an a etting's label. [ Save ] [ Cancel

In the "Or use the following locator javascript function” box, click on the check box to to enable it.
Enter "$adf" in the drop down list.

Click Save to save these settings.

7. Running Browser Standalone

7. Running Browser Standalone

While taking advantage of the full power of LISA (multi-technology, Data Sets, Companions, etc.) requires running embedded in LISA, doing some
quick testing or debugging can be achieved using the LISA browser in standalone mode.

To do this, run the lisa_browser.exe executable in the %LISA_HOME%/bin/browser directory.



lisa_browser.exe -s true [-m <recorder|playback|service>][-f <recording file>]

-s or -standalone should be true to run outside of LISA.
-m or -mode can be recorder, playback or service (service allows remote control through a web service interface)

-f or -file optionally specifies a recording file saved previously from the standalone recorder.

8. Troubleshooting

8. Troubleshooting

Here are a few guidelines that will help you and help us assist you in the process of submitting a ticket, from asking a simple question up to
reporting a severe bug.

In some cases those tips may dramatically reduce the time to resolution.

® Does the scenario you're testing work in a browser (especially in IE since it is used for recording)? If not there is no chance it will work in
the LISA browser.

® Have you read the documentation and made sure your questions are not answered therein? (in particular see the troubleshooting section
)?

® Have you familiarized yourself with the different settings in the browser and checked they couldn't address the problem? E.g. Applets not
being recorded because applet support was disabled in the settings, or a site that uses mouseover events isn't replaying correctly
because mouseover events are unchecked, or timeouts are too low for your applications, etc. (See Web 2.0 Settings)

® Are you sure the test is not replaying correctly because of a lack of parametrization? Specifically, have you looked at the debug output
window (or logs) to see what went wrong during replay (e.g. "could not find element "//DIV[@id='gen542348239" because the id is
dynamic)? For example see the How To for Dynamic Elements.

® Are you providing all the information that we're likely to ask for? If the problem triggers an error dialog, you will have an option of
"Generating an Error Report", which will contain all this required information (and you can send that to us). Otherwise you can look it up in
the Settings dialog (Lisa Browser build number, OS version, IE version, .NET version, JRE version if applicable)

® Can you reproduce the problem consistently? Does it happen only when driven from TestManager or even when using the browser
standalone?

® |s there a public URL where you can reproduce the problem? If yes let us know about it. If not, can you package the pages that are giving
you trouble and send them to us (usually this can be accomplished by navigating to a browser and going to the File menu and selecting
Save As).

If all of this yields nothing useful, we will probably need to contact support@itko.com and have a video conference call (like webex).

NOTE - Please get your system ready to show the wrong behavior to get the correct solutions.

9. Known Limitations

9. Known Issues and Future Work

In no particular order:

® Create an object repository to increase resistance to application change.

® Add the ability to generate test scripts.

® Improve usability, especially around the filters and assertions screens.

® Improve the screenshot algorithm used to capture applets and remote applications images at certain times.
® Ability to use the "Capture HTTP Traffic" mode to replay the tests at the HTTP level if desired (a la web 1.0).
® Full Safari support.

® Various bug fixes

PART 2 - LISA Web 2.0 - How Tos

PART 2 - LISA Web 2.0 - How Tos
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1. Introduction

1. Introduction

This document is a simple list of how-to's that cover typical scenarios and how to deal with them. You should first read the user guide to
familiarize yourself with the basic concepts.

2. Web sites and frameworks

2. Web sites and frameworks

Most web 2.0 sites built today use one or more of many available ajax frameworks, which is where the complexity lies. For a good source of what
those frameworks are today, you can consult ajaxpatterns.org. The following frameworks or websites using a framework have been tested
during development:

Ext (see the demos at Ext JS and Ext GWT)

ICEfaces (see the demos as Components showcase)
jQuery (see Kayak)

Appcelerator (see the demo at Appcelerator Web Unit Tests)
Tibco Gl (see the demos at Xlgnite)

Oracle ADF Faces

Backbase (see the demos at Backbase Demos)
ASP.net Ajax (see the telerik demos at Telerik)
Bindows (see the demo on the home page)

i2 websites (MDM, SCP, etc...) - no public URL available
and many others...

If there are any websites or frameworks that don't work in the DOM browser, please let me know and | will add support for it. There is nothing that
can't be supported (in theory), the DOM browser even works with DOM level 2.

3. How To - Generate random data (4.5.1.x)

3. How To - Generate random data (4.5.1.x)

There are many places in LISA where string generation patterns may be specified. By using a pattern, LISA will create a random string based on
the specified pattern during the run of a test model. A string pattern is made up of a mix of pattern and literal characters that will form the final
string. The following are the recognized pattern characters:

D — replace with a random digit (0-9)
L — replace with a random capital letter


http://ajaxpatterns.org/Ajax_Frameworks
http://www.extjs.com/
http://www.extjs.com/products/extjs/
http://www.extjs.com/products/gxt/
http://www.icefaces.org/
http://component-showcase.icefaces.org/
http://jquery.com/
http://www.kayak.com/
http://www.appcelerator.org/
http://unittest.appcelerator.org/index.html
http://tibco.com/devnet/gi/
http://tibco.xignite.com/
http://jdevadf.oracle.com/adffacesdemo/faces/index.jspx
http://www.backbase.com/
http://bdn.backbase.com/topic/demo
http://www.asp.net/ajax/
http://www.telerik.com/DEMOS/ASPNET/Prometheus/Controls/Examples/Default/DefaultCS.aspx
http://www.bindows.net/

| — replace with a random lower case latter

A —replace with a random digit or letter of either case
P — replace with a random punctuation character (.,-V)
. — replace with a random printable character

So, for example, the pattern "LDDD" will create a string with a random uppercase letter followed by three random digits. To use a pattern in the
LISA browser, the following syntax may be used: =pat t er n (e.g. =LDDD).

Filter Ky rardom| w Browse

] wait up to ms for value

Properties

-Z:I_J::Z' An expression filker allows you to combine other flters or literalks,

() DOM Element Browise
) Text
) DOM Attribate

O Script Browss
® Epression {{=ARAADDDD}} v [ Browse |
() Cache

{) Capture Browse
) Sleep e

) Broviser ntemeet Explorer Firefox Safan

Quick Test

iﬂ\ Click Evaluate to see what value this filker wauld retum if it were evaluated duning the recording

Recorded Walue  STHO744

i Evaluate ] | Clear &l ]

A square bracket expression may be used to randomly select from a specific list. For example, the pattern "[1,2,3]" will create a single character
string that is either "1", "2" or "3".

Any character that is not "D', "L", "I, "A", "P", ".", "[", "{" or "*" is taken as a literal. For example, the pattern "BobDDD" will generate 6-character
strings, all of which start with "Bob" and end with 3 random digits. If you need one of the "reserved" pattern characters as a literal, prefix it with a
back-slash. For example, the pattern "DD\D" will generate strings with two random digits followed by the literal character "D".

With any of the constructs above, there are two types of modifiers that may be specified. A brace expression, "{}", may be used to specify an
exclusion list. For example, the pattern "D{0,2,4,6,8}" may be used to generate a random digit that will only ever be an odd number.

An asterisk expression may be used as shorthand for repeating pattern characters. The asterisk must be followed by one or two numbers
surrounded by parentheses. If two numbers are specified, the must be separated by a comma, dash or space.

When the repeater (asterisk) expression specifies only one number, the result of the pattern will be a string of the specified number of characters.
For example, the pattern "A*(20)" will generate a 20-character string composed of random alpha-numerics.

When the repeater expression specifies two numbers, the result will be a string that is at least the first number in length but no longer than the
second. For example, the pattern "L*(3-5)" will generate strings of random capital letters at least 3 characters, but no more than 5 characters long.

4. How To - Capture Dynamic HTML for later test editing

4. How To - Capture Dynamic HTML for later test editing

By default, when you record a test, the response (html document) is captured only when a new document is loaded in the browser, either trough a
direct navigation or as a result of an ajax load (if ajax callback is checked in the recording settings) so all the events between 2 pages loads will
have the same response (as you can see by looking at the events response tab).

It is normally sufficient and keeps the test size relatively small but for some websites that are very javascript heavy, where the page changes a lot
purely on the client as a result of javascript executions, it can make it difficult to edit the test or add filters and assertions through browsing.



For example if you have a page that has tabs (that are preloaded and just change visibility when you click them) and you click on the second tab
and want to add a filter for some text on the second tab, if you browse on the events tab you will only ever see the first tab:

Browsing of a click event on the second tab without Capture HTML changes:

v WPath | /DIV[@d='script] v | [Highight | [ select ][ Cancel |

F1 1 " = Il = M
C ShowHTML source [] Dul Tahs with auto height that resize to the content. Built from
= 1 5P A existing markup.
eat
= = U Short Text | Long Text
o DIV
@ DV Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Sed metus
DIV nibh, sodales a, porta at, vulputate eget, dui. Pellentesgue ut nisl.
bl D_""’N" w Maecenas tortor turpis, interdum non, sodales non, iaculis ac, lacus
< 2
=a hestibulurm auctor, tortor quis iaculis malesuada, libero lectus
=2l bibendum purus, sit amet tincidunt quarm turpis vel lacus, In
B Implicit ~ pellentesque nisl non sem, Suspendisse nunc sem, pretium eget,
all Complex Obj v cursus a, fringilla vel, urna.
Tagx Tagy
W
Browsing of a click event on the second tab with Capture HTML changes:
| v || Uselns | wPath | //DIVI@id=markup] « | | Highlight || Select || Cancel |
[ Show HTML source [] Out Tabs with auto height that resize to the content. Built from a
s BF & existing markup.
b Ve
[=-<rs DIV Shott Text | Long Text
==z DIV
= DY Larem ipsum dalor sit amet, consectetuer adipiscing elit. Sed metus
= DV nibh, sodales a, porta at, vulputate eget, dui. Pellentesgue ut nisl. —
=< P . IMaecenas tortor turpis, interdum non, sodales non, iaculis ac, lacus.
Pl N estibulum auctor, tortor quis iaculis malesuada, libero lectus
— ~ bibendum purus, sit amet tincidunt gquam turpis vel lacus. In
|%__ 2 pellentesque nisl non sem. Suspendisse nunc sern, pretium eget,
B Implicit N cursus a, fringilla vel, urna.
al Complex Obj + _ -
— liquam commodo ullameorper erat. Mullam vel justo in negque
Tag# |:| Tag* porttitor laoreet. Aenean lacus dui, consequat eu, adipiscing eget,
— e nonumimy non. nisi. Maorbi nunc est. dignissim non. arnare sed. luctus o

If you add Capture HTML changes, what happens is the response is captured on more types of events such as change or clicks, which will make
the page as it looked at the time of the event available to you when you browse.

Capture HTML changes

Capture Diff Size 1000 % | Butes
Capture Max Time 1000 % ms

Of course if that was the end of the story this would dramatically increase the test size, so to avoid this, there is another setting which is Capture
Diff Size. What this does is that it compares the size of the change between the page as it is now and the page as it was when it loaded, and if
the size of the change is above the number you specify in the settings, it will capture the whole page as it is now, but when the size is below that
number it will only keep track of the diff, which is usually quite small and the response for the event is automatically rebuilt for the user from the
page load response and the diff.

The reason it doesn't always do the diffs is because above a certain size they become very expensive to compute and would take too long (which
is where the second setting, Capture Max Time comes in).

The defaults are set to reasonable values and shouldn't need to be changed in general. So if test size is not a concern, it's nice to have this
checked to make it really easy to edit the steps/filters later on.

5. How To - Deal with time-sensitive events



5. How To - Deal with time-sensitive events

A lot of what makes web 2.0 sites difficult to test is the asynchronous nature of their interactions with the user. In a pure request/response
environment, there are no race conditions or multiple threads of execution to worry about (at least from the client's perspective), but web 2.0
environment introduce those difficulties everywhere: frames, set Timeout and particularly asynchronous ajax calls in html pages as well as any
java applet code or flash/flex code make heavy use of multiple threads of execution.

The main testability problem it creates is unpredictability. The application may be in a different state as any given event executes during two runs.
If you need to capture a value on the page that is updated asynchronously, when do you do the capture? Right after the event, or a fixed amount
of time after it? For example, when do you capture the price of a dynamically configured item as in the picture below?
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W Intel® Core™ 2 Duo TSETO0 (2 0GHZBODMHz FSB/ZMB cache)

[subtract $150]

) Intel@ Core™ 2 Duo TE100 (2.1 GH2B00MRz F SB/3ME cache)
[inchuded in Price]

) Intel@® Core™ 2 [uo TEH300 (2 5GHzB00Mhz FSBEME cache)

[add $250]

h_ﬁ Print Summang

Iy System Details A
= Inkel@® Core™ 2 Duo TE100

| (2. 1GHZE00 Mhz FSBSME cache)

= Genuine Windoves Vista® Home Basic,

Senice Padk 1

=1 Wear Basic Limited Warranty and 1 Year
HBD On-Site Samwice

« 170 inch Wide Sorean XGa+ LCD
Display with TrueLife™

-_r Go to Next Component

The DOM browser gives you 2 powerful tools to deal with those situations:

® The Synchronize Ajax calls setting

General Hecnrding| Flayback | Info

[] Fail step on miszing target.
Synchronize Ajaw callz.
[ Usze Hardware |nput

This will force all ajax calls made by the application to be executed synchronously so no event, filter, or assertion will execute until the event that
triggered the completion returns (note: some websites, that do ajax event pushes through regular polling, are not working well with this setting. If
you don't know how the application is coded, just give it a try and see if it works or if it seems to freeze the application from time to time). This is
especially useful when there is no visual cue as to when the code completed, as in the example pictured above.

® The wait for option of any filter.

Defrtion

'ﬁ} A fier is a function that executes before or after an event i tnggered and stores ks result [Fiter Value] in a vanable [Fiter Key]

Filtes Key ‘whaitF orS ometihing ~
[] wait wpto (10000 % | meforvalue |Matches e v

This will make the test execution wait until either the wait for condition is met, or the timeout specified expires. You can see an example of how to
use this in the Autocomplete section. Another typical use of this is for pages that have splash screens. For instance, if the splash screen is a div
containing the text "Loading..." you would pick a text filter with DOM element the splash div (which you can identify by adding a quick filter while
it's shown onscreen for example) add a "wait for" condition with an operator of "Does Not Match" and a value of "Loading...".
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6. How To - Parametrize dynamic data entry in loops

To understand this example, you should first be familiar with XPath expressions, as described in Web 2.0 XPath.
Let's look at a couple of typical scenarios to understand how to deal with dynamic data in a loop.

First, let's say you have a list of cities in a table with a checkbox next to them, and you want to check the checkboxes.

The code for a table row here is

Anstin
Drallas

Mletropolis

O 0O 0 0

Fotham

<tr>
<td><input type=checkbox></td>
<td>Metropolis</td>

</tr>|

If we want to check them all it is very simple, we record the clicking of just one of them which will result in a change event with an XPath value like
/HTML/BODY/TABLE/TBODY/TR[1)/TD[1}J/INPUT.

So first we define a looping variable. The easiest way to do this is create a filter of type Expression on an event before the change event, let's call
iti and set its value to 0.

Then we parametrize the XPath of the change event to be something like: /[HTML/BODY/TABLE/TBODY/TR][i }/TD[1}/INPUT. To increment the
value of i, we can create another expression filter on the change event with key i and value i + 1. Each time this filter executes this will increment
the value of i by 1.

Finally we need to loop onto the change event until i is greater than the number of rows (in this example 4, but we could dynamically compute the
number of rows first), so we add an assertion on the change event whose expression reads If i Less Than 5 Then "Go To change event". That's
it.

Alternatively, if you are coding inclined, you can simply create a javascript step whose DOM Element is the /HTML/BODY/TABLE containing the
cities and with the following script: "for (i=0; i<4; i++) _arg.rows *# cells(0).childNodes(0).checked=true; return 0;".

Ok, now for something a little more complicated, let's say we have a list of cities coming from a Dataset along with population number and we
want to input those values on the page:

The code for a table row here is

City Population
Anstin
Dallas

Metropolis

O O 0O O

Gothatm

<tr>
<td><input type=checkbox></td>
<td>Metropolis</td>
<td><input type=text></td>

</tr>|

Here the technique is different because instead of iterating based on the elements on the page, we terate on a dataset and look up the
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corresponding elements on the page. Let's first create a web 2.0 dataset using a script filter:

(% Javascript Filter

Help | SGL generatars |

(%) File Data Source |I::"-.|:it_l,l.:-:ls v| [ Browse ]

i) DB Data Source <Connection String:

Generate from Cuen:

Script | Results |

City Population &
1000000

Dallas 4000000

Gotham 7000000

Metropalis 2000000 v

[ Evaluate ][ Save ][ Cancel

The process is very similar to the one we just followed: first we record checking one checkbox and entering a value in the corresponding text field.
It can be any box, the goal is just to generate 2 changes events, one for a checkbox, one for a text field.

Then we create the i looping variable before any of the two change events and we parametrize the XPath of those change events. To do this we
can no longer rely directly on the index but instead on the values coming from the dataset. To make things clearer, we can define a couple of
script filters called city and population with the following scripts:

return ci ti es.rows(i ).cells(0) and return ci ti es.rows(i ).cells(1).

Now we can use those variables in the XPath on the 2 inputs by first identifying the city name cell: /[HTML/BODY/TABLE/TBODY//TD[text()="ci t y
'l and then navigating the DOM from there, which gives us: /[HTML/BODY/TABLE/TBODY//TD[text()='ci t y')/../TD[1]J/INPUT and
/HTML/BODY/TABLE/TBODY//TD[text()="ci t y']../TD[3)/INPUT. At the same time, we parametrize the Value of the second change event to use
the value coming from the dataset: popul at i on.

Finally we add the filter that increments i and the assertion that loops onto the first change events while there are more rows in the dataset. The
screenshot below shows what the test case looks like after adding those filters and assertions.

- ﬂ 0] navigabe [Hitp: MocalhostAtko/datasat himl) Propeies  Flesponse | Headers
T Physical Events

= Fiters Gerersl Propelies
@ Jawascipt: cilies ﬁ' Propeitios comman to all event lpe:.
Composite i i
Lszetiong Ewvert Souce | DOM Evert w “windove |0 w H 16 b
=@ 1) click on BODY [CtyPopulation]
58 Physicsl Events Evert Type change L Key w Ny 48 -
= Filteaz T
q g Javasoipt: city Frame w Modifers | Laft Button w Think i} =
& Jawascipt populstion
. h Aastions D0k Properies
= [## Z)change on INFUT type=checkbox fiue]
% [3 Phusical Events @ DOM popetties uniguely idertify an element and its value on a page
 Filt
R Ud | bttpc/ flocalhast/iko/dataset himi v
- L. #Path  AHTHLABODY/TABLE /TBODY AT bexl)=" ek} ATDIANPUT | | Browse
# | & Phyzical Events
Filters vaue [l o
Bisaibong
= {8 4)click oo TABLE (ChyPopulation] Tag  (INPUT | Type [t
+ B Physical Events
- a Filleis
ﬂ: Compositer |
- h.b.ﬁaniw

l Base Acembor {{i)) Less Than 4

All of this can also easily be accomplished in a code way as follows:



for (i=0;i<cities.length; i++)

{

city=citi es.rowsﬁ.cells(O);

population =ci ti es.rows'ﬂ.cells(l);

lisa.select(document,"/HTML/BODY/TABLE/TBODY//TD[text()="" + city + "]/./TD[1)/INPUT").checked=true;

lisa.select(document,"/HTML/BODY/TABLE/TBODY//TD[text()=" + city + "]/../TD[3)/INPUT").value=population;
}

return O;
7. How To - Deal with dynamic elements

7. How To - Deal with dynamic elements

To understand this example, you should first be familiar with XPath expressions, as described in Web 2.0 XPath.

One of the main problems facing recording/replay tools is that of identifying elements on a page or in a control using various properties of the
element, such as html attributes, text or value, position in the DOM, position in the page, etc...or any combination of those. Most of these tools
boast various algorithms to optimize identification without getting false positives, and the DOM browser is no exception.

The primary means of identifying an html element on the page is through XPath. Those XPath expressions are automatically generated but can
also be modified or parametrized to improve reliability in some cases.

In the vast majority of cases, the id attribute of html elements is a reliable way to identify them so it will be used whenever possible. However,
those ids are sometimes dynamically generated and will change from run to run, sometimes for good reason (as in websites that have dynamic
layout), often as a result of poor coding. To avoid having to manually parametrize all these xpaths to make them more reliable, there is a
recording setting, Exclude ids matching, which will automatically prevent ids whose value matches the supplied regular expression to be used
during recording. The rationale is that dynamic ids frequently follow a certain pattern, such as having multiple digits (and the default pattern is
indeed 3 digits or more).

Generally, other typical ways to identify elements such as text or value are easily expressible as xpath as well, using the syntax
IITAGNAME[@attributeName="'value'] e.g. //A[@href="www.google.com'], or //DIV[text()="Some Value Here']

Here is an example of combination of these techniques to identify more complex elements:

¥ WPath | ATD bet)="Tatak ). /TO[2)/00 v | [ Highight | {_Select || Cancel |
] ShowHTML soures [ Outlr kil ~
=« TR ~ % .
S TD . our running
& HR Jate your systermn price as total
=« TH
5-d D L Price $699 99"
sxk T okal
@ T nstant -$100.00
- &E rebate
w=t 359999 -
E — . Total: $59999
w5 |4] You saved 14.3%
- | L
=2 :mlieit _— thA as low as $20/mo*
RO 0
attnbutes Complex Obje ¥ jil:g n:;?:_'{ri::;:r: o
Tag¥ Tag™ Estimated build date: =

In the picture above, if the DIV element containing the price has a dynamic id (i.e. it changes from run to run), we don't want to use it. So we
Browse and pick the closest element we know doesn't change, in this case the TD whose text is "Total:". Then we navigate up one level using the
.. operator, and then back down a couple of levels using the DOM tree as a guide. This gives us the following xpath:
/[TD[text()="Total:")/../TD[2]/DIV. The Highlight button confirms our guess.

8. How To - Extract complex data from a page

8. How To - Extract complex data from a page
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To understand this example, you should first be familiar with XPath expressions, as described in Web 2.0 XPath.

Most interesting assertions rely on data that has been extracted from pages through the use of filters. The vast majority of cases will require no
configuration and will automatically pick up the data you want:

Element filters will select the desired element (to verify it exists for example) and fill the filter value with its xpath. The element will be already
chosen for you if you use a filter add during recording (Add Quick Filter or Add and Edit Filter). If you do it post recording, the browse button will
easily let you do it visually.

Text and Attribute filters work the same way, there is no work required other than deciding on a regular expression for Text filters (which 95% of
the time will be the default (.*) to capture the whole inner text), and as for attributes, the list of available attributes will be prepopulated in the
drop-down after an element browse is completed.

Let's take a look at simple example: we add a user to a list of users and it shows up in a table with ID, Name and Email. We want to make sure
that the user has in fact been added and that the email field value is what we think it is:

‘Wednesday, May 28, 2008 View Users

Welcome iTKO | UserlD Name Email

userCO0asS0AC 000, . userCOAS0ACE0000011ASG22E..
moultitier-4 3784 ., rall rall null
m mgltitier-64 966, null null null
mulktier- 10045, rull Aull null
Walug null mull null
- userCO0AS0078000,. rall muall nufl
userCOAs0078000.. niall muall nufl

We can first add a DOM filter, and browse for the row we want in the table. We'll get something like:

/IFORM[@name="edit_users'[/TABLE/TBODY/TR[493]/TD[1]/A.

v HPath |Jf'FuHM[@nm-'ua_usmwABLEnanDwrn[w.wm[l]m | | Highight || Select || Cancel |
e [] Outine Tags helln aull rull null *
m test null null oull
@ ‘_""LE . test2 null null aull
o e id id 1di@id.com
= mj_? . userb23IZ6161616,, usert2Zi2el6161663331206646.,

Of course, this is not reliable because the row number (493 in this instance) could change, so we need to parametrize this expression to use the

user name instead. We keep as much of the computed expression as possible, in this case
/I[FORM[@name="edit_users']/TABLE/TBODY
and then we look for the A element whose text is the user name, something like

Altext()="jdjd].

This gives us the following expression: //[FORM[@name="edit_users'[/TABLE/TBODY//A[text()="jdjd']. Note the double // before the A to specify we

search children of the TBODY down to any level.

All we have to do now is add an assertion that verifies the value of this filter is not blank, which will indicate the presence of this row in the table. In
the same way, to capture the email of this user, we use a text filter where we start with the same expression:

/IFORM[@name="edit_users'[/TABLE/TBODY/TR[493]/TD[1]J/A
then we go up two levels to the table row:
/I[FORM[@name="edit_users'[/TABLE/TBODY/TR[493])/TD[1]/..
then we pick the anchor in the third cell of this row:
/IFORM[@name="edit_users'|/TABLE/TBODY/TR[493]/TD[1]/../TD[3)/A

At any time we can use the Highlight button to verify we're selecting the right element.

w|[Useln-: | %Path |//FORM[@name='edit_users ]/ TABLE/TBOD'Y //Alles)='did)/.././TO[VA s | [ Highight | [ Select | [ Cancel |
=[] Outire Tags test null mull null b
b null A testZ rull ol null
=S- 10 | idid id id
= A |
wk UEErG 220100016, . UsertZ3261616166333120666.,
i "'f’ TR . user7FOO0DI01000,, userTFO00L010000011AZ05ES .,

Now we just have to add an assertion to make sure the value of this filter is indeed the email we think. Of course, all of these values, such as user

name, email etc...can be parametrized in the usual way user nane, enwi | , etc...
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For the cases when you need finer-grained control over the retrieved data, you can use the Script Filters. They give you full control over the DOM
(or the applet hierarchy when testing applets). As an illustration, let's reuse the previous example, where we want to extract data from the table.

The first thing you would do in a filter is select the DOM element to be the table (by browsing as usual). This gives you access to the table object
in script as the _arg variable (see the _arg scripting object). Then you can easily retieve all kinds of information:

Number of rows: return _arg.rows.length

Text of the 3rd cell of the 12th = return _arg.rows(11).cells(2).innerText
row:

Text of the last row: return _arg.rows(_arg.rows.length - 1).innerText

Email of the user jdjd: for (i=0;i<_arg.rows.length;i++) {if (_arg.rowsﬂ.cells(O).innerText=:'jdjd') return _arg.rowsﬁ

.cells(2).innerText;}; return null;

Etc...

Froperties
f@ A scnpt flter execubes & javascipt furction [that must return 8 value) on the HTML document of the svent response

©) DOM Element | //FORM|@name='edil_usersJ/TABLE v

.

) Tent

) DOM Attpbute

® Scaipt rebum _aig rows(11] cells[2)innerTexd w

() Exprassion
) Cache

Quack Test

Browze

ﬁ'@ Chck Evaluabe to ses what value this filkes would return i it were evaluated during the recording.

Fecorded Y alue James Kik@5tarT ek com

l_ Evaluate ][ Claar All ]

Finally, some dynamic data is automatically extracted for you, most notably request string parameters and cookies:

Ky

{levert.cookie NID |}

{{evert cookie PREFH
{{evert frame.path} }

Hevert pararm an) )

ot param hi}

{{evert patarm oal)

{levert param g}

{[evert pathi]

{levert rezpanze.rendes time. st}
{levent response.render. time
{levert responze timel}
{levert responzel}

lewver seript emo}

{{evert slabuz codel}

Hevert ypell

Hewvert urlt)

<

W ahue
15
[[n]

en
tho

Hoo

HDIV]Eid=%adsOLLI

a7

47

15

{HTML> <HEAD < TITLE »itko - Google Search</TITLE»<META http-equrvscontert-type contert="tex

200
MOLEEOYE]

Fittpcd Aavan, google. com/zeanch thi=enbge=tholag=tkog=

As shown in the picture above, string parameter names are prefixed with event.param and cookie names are prefixed with event.cookie.

9. How To - Ajax auto-complete fields

9. How To - Ajax auto-complete fields

One of the most pervasive ajax controls is the so-called auto-complete (or type-ahead) control, which prompts the user with a list of choices even

as they are typing letters in a field.
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itk

itko lisa 25,200 results
itkowitz and harwood 245 results
itk owitz harmvood A37 resulis
ithko inc 0,400 results
itko.com 11,200 results
itko dallas tx TED results

cloge

To record and replay this type of interaction, there are a couple of things to be aware of.
First, the keypress event should be enabled for recording (as it is by default) in the settings. In most cases it can be disabled and it leads to leaner
test cases but in this case it is needed.

Then, when you replay the test, the drop-down is populated asynchronously, so if you take no precautions, you may execute the next event or a
filter, or an assertion before the drop-down is populated. There are 3 ways to deal with that, as explained in the Time Sensitive section:

® Using the Synchronize Ajax calls setting.

® The next way that is very simple is to add a filter that waits for a certain amount of time by specifying a never met condition, thus giving
the call enough time to complete.

Defintion

l@l A, filker is a function that executes before or after an event is triggered and stores its result [Filter Walue) in a variable (Filter key).
Filter K.ey |W’aitFiIter1 w | [ Browse ]
i ait upto 10000 2| msforvalue | Equals ~ | r'-JE'-.-'Er T e w |

® The last way, which will always work but requires a bit more work is add a filter that waits for a specific condition to be fulfilled. In this
case, the condition would be that the drop-down is visible and shows a certain number of rows for instance.

Typically, you would add a script filter on the event that triggered the drop-down, then browse for the DOM element and pick the drop-down
popup, as illustrated in the picture below (from the search on www.newegg.com).

v WPath | H/DIV|@ide"autckilechiow] v | [Highight | [ Select ][ Cancel |
[] Show HTML souce  [] Outine b

s TD ~
=<5 TD
0 [NPUT
«» BR
= <
# e DIV
+ e DIV
# e DIV
# e DIV
+ e DIV
4« TD w

Text Search Terms: ¢
What You're Loo

el
[t
—

Tagx Tag™'
) Fimml e ™emmbadon U Rdmm e, ™

Then you would specify the script snippet to return something meaningful for this site. For instance, in this case, you can see from the picture
above that the drop down is a div tag and each row is made up of a child div tag (easy to see from the DOM tree). So a meaningful filter script
might return the number of rows: return _arg.getElementsByTagName("DIV").length (see the _arg scripting object).

Finally, since you expect the filter value to be 5 in this instance, you would specify in the Wait value box of the filter, and the filter screen would
look like this:
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Defintion
'I_E' A, filker iz a function that executes before or after an event is triggered and stores its result (Filter Walue] in a variable (Filker Key).

Filter K.ey |WaitFDr5HowsDrMore w | [ Browse ]
W ait upto (10000 o | msfor value |Mme Than v| |4 v|
Froperties

'ﬁ' A, zonipt filker executes a javascript function [that must return a value) on the HTHL document of the event response.

O DOM Element | #/DIv@id="autoflledview] v | [ Browse |

) Text
() DOM Attribute

(%) Script return _arg. getElementzBuT agMame(" DIV length v| [ Browsze

() Expression Browse

() Cache

Cuick Test

'ﬁ' Click, Evaluate to zee what value thiz filker would return if it were evaluated during the recaording.

Recorded Walue 3 |

Evaluate H Clear All ]

As you can see from the picture, the Quick Test can be used to tell you if the script you're using is correct and returns the desired result. Also,
note that to see the drop down visually in the Browse window, as is pictured above, you will need to enable the Capture HTML changes setting
in the recording settings as explained in the Capture section.

You are now ready to add more filters for data extraction and assertions for validations. This is more thoroughly covered in the Data extraction
section but in this instance, a very simple filter might be a Text filter with a DOM element set to be the drop down element, which will retrieve all
the text contained in the popup:

Properties

'ﬁ' A, test filker retrieves the inner text of a DOM element using a regular expression [first captuning group).

©) DOM Element | #/DIV[Gid<autofiledview v | Browse |
(=) Tewt [ v|
) DOM Attribute

) Seript Browsze
) Expression Browze

) Cache

Cluick, Test

'ﬁ' Click Evaluate ta see what walue thiz filter would return if it were evaluated during the recording.

Recorded Value graphic: card(1773)graphic cardz(1773)graphics(1976)Graphics Card(1773)araphics cards(1773) |

[ Evaluate ][ Clear &l l

Then all that is left to do is add an assertion that checks some given text is contained in the value of this filter (using a Basic Match assertion).

10. How To - Write custom Web 2.0 steps

10. How To - Write custom Web 2.0 steps

Many record/replay tools let you (or even require you to, if there is no recorder) write scripts to control user actions. There should generally be no
need to do this as the recorder is good at capturing all user interactions, but it may still be useful in certain cases.

For instance, if you have a page with many checkboxes that you want to check, the GUI way to do this would be to check one, and then to
parametrize it so that it can be embedded in a loop that will visit all the checkboxes with the change event (see the parmetrization section). If you
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have 2 levels of loops or other constraints it will be quite tedious, but it could be quite easy to do in a script.

3% Javascript Filter

Help | S0L genesators

@' The hites walue wil be detesmined by the refurn statement of the javascnpt snippet below.
The specaal variable _arg references the DOM elemert of the filker.
The specasl variable liza iz a global object that provides wlilty funchons to pesfomn <PATH or SOL quernies.

o can use the olher 1abfs] 1o generate predefined code blocks.

Scipt | Resuits|
[var eh = docusment getE lementsByT sgMameINFUT"):
for fi = 0:1 ¢ chlength; iv+]
i [chi] ype == "checkbox)
: chi] checked = frue;
t

rebum [

E valuste H Save Jl_ Cancel ]

When you create a hew step in the Events tab, a new event of type script gets created. It does nothing by itself but contains a script filter that can
execute arbitrary javascript (or java for applets). The image above shows the script dialog that gets opened when you click the Browse button of a
script filter. In this instance, it iterates over all checkboxes on the page and checks them.

11. How To - Write cross-browser tests

11. How To - Write cross-browser tests

The first thing to know about writing tests that run in multiple browserss is that there is nothing special to know. You would author, record and edit
the test in the exact same way you normally would a test designed to run in a single browser, and during playback you simply select which

browser(s) you want to run the test.

In the screenshot below, note how the Internet Explorer and Firefox buttons are pressed in the toolbar. This will cause both browsers to be used
for this test. You can select Internet Explorer and/or Firefox and/or Safari to run a test.
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While Internet Explorer is always installed on Windows, other browsers require an initial download. Every time you attempt to use Firefox or
Safari, if those browsers have not been installed you will get the following prompts:

8% XULRunner Download Required

@ To use Firefox, a one time download [sulmnner 1.8.170s required.

Dravwnload from: |it|:u:.-’a’ftp.mu:uzilla.|:|rga’pul:ua’:-culrunnera’releasesﬂ .81 i

Save contents to; |E:'\Dncuments and Settingziall Llsers'\.-'-‘-.pplicatiun|

Download Status [ ]

[ Download ][ Cancel J

8% Safari Download required

@l To uze Safan a one time download is required.

D awwrload from: htt v apple. comdsat anddownloady

Statusz: W aiting for download to starb.

Download ][ Cancel

There is no difference in how events are executed in multi-browser mode, they are just executed for each browser. Assertions are just executed
once since they don't depend on the browser, the only thing to pay attention to is filters because they highly depend on the browser.

First off, we can not execute filters for each browser without any changes because if we did, the filter value coming from one browser would
overwrite the filter value coming from an other one since they have the same key.

This is why when multiple browsers are used, the keys used in filters are still in use but there are automatically new filter keys being generated,
one for each browser, to allow us to distinguish between the filter values coming from different browsers. The convention is to append 2 letters to
the filter key: key.ie (for Internet Explorer) or key.ff (for Firefox) or key.wk (for Safari).

The screenshot below shows what happens when we define a javascript filter called allcount with code: "return document.all.length;"
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Since the different browser evaluate this javascript expression differently you see 3 values for the allcount variable: one for IE, one for Firefox, and
one default one (IE in this instance) so as to not break assertions written for single browser mode. Now we can write assertions that compare
allcount.ie and allcount.ff for example. This is particularly useful to compare rendering page properties, by writing filters that return object positions
in the DOM and comparing their values in different browsers.

Finally we need to be able to automatically control which browser(s) is (are) selected in general, or for a given test, or even for a given step. There
are 3 ways do do that, one for each level of granularity. To control globally which browser(s) is (are) used by default, the "Default Browser Mode"

section in the settings should be used.

Drefault Browser Mode
] Intermet Explarer
Firefox

[] Safari

At the test level it can be overriden using the usual mechanism of defining the following property: DEFAULT _BROWSER. It can take the value
NONE, IE, FF, WK or any pipe-delimited combination of those (like IE|FF).

Finally, at the event level, which browser is being used is controlled by the Browser filter:

Properties
'ﬁ' A browzer mode filker toggles the state of the plapback window to uze the selected browszer(s).
W 1ERL b

7 DOM Attribute

) Script Browse

) Expression Browse

) Cache

{*) Browser [] Intemet Explorer Firefox Safari b

When a browser filter executes, it selects the browsers specified in the filter to run from that point on. Typically you would use this filter just prior to
looping in a test case, so you could run a step of steps in a given browser and then again the same set of steps in an other browser to compare

the results.
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Pathfinder is a server-side LISA component that can be used to make information about what happens on the server available to the client. You
can enable it in the settings dialog by checking the "Enable Pathfinder Integration" checkbox. This will automatically turn on the "Capture HTTP

traffic" option as well.
The main effect of turning on this option is that several new variables will be automatically made available as can be seen on this screenshot:
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In addition to the variables listed in the User Guide's Filters section, a few more can be seen:

event. response. server. ti me measures the time it took the server to generate the payload received by the client for the last transmission.
event. response. net wor k. t i me measures the time it took the payload to go from the server and reach the client.

aut o vari abl e nane are custom variables defined by Pathfinder to represent some variable value on the server and made available for
inspection one the client.

Note if those variables are exposed by the LEK they will be available automatically even without Pathfinder integration.

event . pat hfi nder is the most important variable. It is an xml representation of the Pathfinder payload and contains all pathfinder information,
that can then be extracted using XPath expressions, with the lisa.pathfind API.
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For instance, to get the query string out of the first SQL statement in the payload pictured above, you can use return


http://www.itko.com/download/release/lisa_browser/docs/web20reference.html#pathfind

lisa.pathfind('//sql/attribute::sql'), which will return SELECT * FROM users.
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Authoring Swing tests is practically no different from writing applet tests. From a GUI perspective, the only difference is how you launch the
application.

Address | about:blank v|r;3 v| | Recording [ [ -
L| PLUGINS | APPLETS | SWING | MET | EVENTS| @ Navigate l
£%  Browss for HTML

Ii’ Browse For Java |

@4 Erowse for JNET

Instead of navigating to a URL, you browse the filesystem for an executable or batch file used to launch the swing application. In most cases the
executable is going to be java.exe or javaw.exe and you can specify the command line (including classpath, VM arguments, etc...) in the Open
Dialog window, as well as the start directory (optionally). In other cases the application is launched from a pre-packaged executable (as LISA
TestManager is for instance) or from a batch script. This is supported too and makes no difference.

Open
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Etest.bat
TestManager . exe

IE'TestRunner.exe

by Documents

o

ky Computer

‘% File: narie: |TestManager.e:-:e b | Dpen
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Startup Directony | W I
Or Attach To | w | Aftach |

Below is a screenshot of a few events recorded against a Swing application, you will notice it looks almost identical to Applet events, except for
the Applet field, which is now a JFrame.
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You can similarly browse for offline editing and bring up the Applet/Swing browser to change and/or parametrize event targets (note the red
highlight rectangle below is part of the application, not a screenshot artifact):
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Finally, Swing applications also have their own live instance browser under the SWING tab (in both recorder and playback modes). When
selecting a component in the swing hierarchy, this component will get highlighted in the live application so you can easily verify which elements
you are targeting (note the red highlight rectangle below is part of the application, not a screenshot artifact):



% LISA Browser (4.5.0.7) about:blank

e
il iitnesy > o o o EL-0-1 6 k80 0|

| WEB | DOM | HTML | PLUGINS | APPLETS | SWING | NET | EVENTS|

‘Swing Application | Swigset o ﬁJ
= [ iavaxzwingJFanel -~ i_=|il =z
= |:I javax swing.JFanel — -
= [ iavax swingJPanel B ,'“a'“tw &
@ izvasving JRadioButton [Radic One | = !avn_ﬂt_l:uim
@ iavan swing BoxdFills @ Ivms sing.JConpenet
O iavassvang JR adioBution [Fado Twa) - E"Mncmt '":'""9' win,
| ACCES: [ I
SwingSet =13 sctiorMap
- i — aignment=] 0.0
.E||E Look & Feel Themes Oplions | slignmenty oo
. | = | e | | =1 | iOm 0 ancestolnputhd mull
2 CEREEEEL] S - ——
= = = = - : Twal et javax. swing. bod
Button Demo | Source Code | clentPiopetties null
 ppp— — — —_— 1 "ﬂ 5 9
; Thi g
(Buttons | Radio Bulons | Check Boxes | ] ree) focusinoubap | mdl
inpuy erifier mull o
- A - ~ : Display ¢ S FR— —
| () Radio One () Radio Two () Radio Three ] Pain SoveE tawi 1ED p
Press Shift-F 10 to activate popup menu 5 ]
Y Applet Window =
"_/ -

Note that the exact same things apply to Java WebStart applications except that they can be launched directly from a jnlp link in a browser web
page. The test will then automatically mix web steps and swing steps.

Support for arbitrary beanshell expressions is supported just as in applets and the last event target can also be referred to with the special
variable _arg. You can test your java filters in the debug window by setting the mode to ".swing" and then evaluating the expression:
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An example of how this would be useful is when the text filter is not easily able to get some value onscreen, in particular if you have a JTable, you
can not get its cell values unless you double click them because the cells are not swing components (until they are double-clicked). With a script

|




filter, you could simply select the table as the component and then write a script like: return _arg.getModel().getValueAt(2,3);

Finally, an interesting point to note is that while this step's primary purpose is to do Swing or AWT testing, there is nothing that prevents you from
running against headless or console java applications. You can run "in-container" tests by specifying any scripts you want in java script nodes.
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Coming...
15. How To - Debug a test

15. How To - Debug a test

Unexpected behavior can occur during recording or replay, and for both cases the best approach is to debug the test directly in the DOM browser,
since it acts as the test execution environment, and is just driven by LISA during staging or ITR. The only exception to this rule is if the test must
use multiple iterations of a dataset or variables defined in non-web 2.0 steps, because LISA takes care of sending those values to the DOM
browser environment.

The main tool as your disposal to understand what is happening in a test is the debugging window, which you can toggle both in recording and
playback mode by clicking the red debug icon in the toolbar:

Recording [ m vg * [l }@ : @ ®|

You can also toggle it by click the little status icon in the bottom-right corner of the screen:

|E® Enable Script Debugger

This icon has 3 states: a green checkmark to indicate no errors, a spinning wheel to indicate a document is loading or an orange icon to indicate
there have been errors, most of the time script errors, but they could also be non-critical DOM browser errors. Script errors are sometimes difficult
to debug given just the error message, hence the little popup menu as seen above to enable or disable a Javascript Debugger.

By default all debuggers are disabled to not interfere with the recording or playback, but if you enable it and there is a script error, you will see this
error message popup:

& Runtime Errar has occurred,
Do wiou wish b Debug?

Line: 0
Error: 'document, tidez walue' is null or nok an object

| tes | [ Mo

Clicking "Yes" will launch the debugger and show you all the details about the script error. Other than that, just opening the debug window will
suffice in most cases:
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In recording mode, 2 tabs are available in the debug window, the Output tab as pictured above and the Immediate tab. The Output tab just logs all
messages (informational, warnings, debug as controlled by the log settings) and the Immediate lets you do more active debugging by typing in
commands. It behaves like an interactive prompt on a web page and supports built-in commands, javascript and java (including the use of
variables, as denoted by the usual syntax var i abl e). It also supports point-and-click interaction with the currently viewed document as illustrated
below:
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By right clicking on an element, you get a menu that contains a Debug entry, to let you view the element in the DOM view or in the Immediate
window. If you choose Immediate, you will be able to evaluate any DOM or javascript expression on the element, helped by intellisense:
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This can be helpful in writing script filters but also to inspect javascript event handlers for instance. All built-in commands can be accessed by
typing a dot (.) as the first character of the line. You can display what they do using the .help command.
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For instance, there are a .js and a .java entries that allow you to swap between javascript and java syntax for commands. The last element to
receive an event can be referenced as the special variable _arg, just like in script filters.
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Note that all these javascript and java (beanshell to be exact) expressions can be used in filters so this is a useful way to design your filters during
recording.

Most of the debugging will probably take place during playback since it will put to the test both the test design and the application under test.
Playback offers the same debugging window with the Output and Immediate tab, and also a Variables tab. Most errors or warning you will see
logged in the Output tab will be due to the failure of identifying an element on the page or in a control (as seen in this screenshot).
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There could be several reasons for this: a genuine bug in the system under test or a failure to adequately parametrize a dynamic element (see the
Dynamic Elements section). You will also see the filters and assertions being executed and their values, so you can quickly see why an

assertion fired for example.

The Immediate tab behaves the same way as in recording mode. The Variables tab will list all the variable values for every step (highlighting in
red the ones that were just modified). This is particularly useful when you set breakpoints or step through a test as in a debugger, you can

observe the value of all the variables:
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Finally, severe errors won't be caught and logged in the Output tab of the debug window, but instead will generate a dialog like:
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[ Generate Emror Report ] [ Cloze

In most cases (especially during recording) you can close the dialog and proceed but not in all cases. And since it should not happen, you can
report it by clicking the Generate Error Report button. This will create a zip archive containing information about the environment, the settings,
the current recording and playback, all the logs including the exception and a screenshot, and then present the user with the following dialog:

=13

0 Ca pture Information

Wiew
@ You may view the contents of the zession capture at:
|E:'\Ducuments and Settingshjd'Application Datatzession.zip | [ Wig
Ernail
@ Or you may email the file directly to support after providing the information below.
v || Emai

| <Enter your email address here:

<Enter problem description herex

You can open the zip archive by clicking View and then email it to support by clicking Email after flling the required information for
troubleshooting. If there is an SMTP server running on the machine (if IIS is installed for example), the email will be sent automatically, otherwise

the default email client will be opened. If there is none, you will have to email the file manually.
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The web 2.0 browser provides the ability to execute global filters and global assertions, that is filters and assertions that execute on every step. If
you have repetitive actions you need to take, rather than defining those manually on every step, you can do define them once, globally and they
will execute after every step. Global filters execute before local filters and global assertions execute before local assertions.

Adding a global filter is very similar to adding a normal filter or assertion. You go to the EVENTS tabs and select the "Global Filters" or "Global
Assertions" collapsible panels.
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This picture, for instance, shows how to capture screenshots on every step and save those in a specified directory for later investigation. Another
typically useful usage of a global assertion is depicted below
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This verifies after each step that the server did not return an internal error code.
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LISA has many steps to interact with external resources, be they flat files, excel files, databases, etc...and all of these resources will be
automatically available to web 2.0 steps when run through LISA. However, if you run standalone, or through LISA but in the debugger, the

external LISA steps won't execute and the external data won't be available. That's why there are ways to access external data from the DOM
browser too.

First, there is the concept of web 2.0 dataset. Those are defined directly in the browser and don't depend on TestManager. To define them, you



go to the EVENTS tab and select the Datasets collapsible panel, then Add a dataset. The details panel lets you specify its name, its data source
and makes it easy to test:

9 LISA Browser (4.5.1.0)

i File FErowsng Recordng  Help
P B o e | Addvess Recarding [ [l - €3 - 00 | 5 & Q @&
WEB | DOM | HTML | PLUGINS | AFPLETS | SWING | MET | EVENTS
Logical Events g] Object Details |
Global Filters 9] 'ﬁ' [Drelie your dataset below
Global Assertions u] Hame [ ciums -
(%) Spreadthest
Fle LIS A HOME [datasetseiy s v
O Database: Oracle SHL Serwer alul.»
SOL | Resuts
City Popsltion -~
N
Dalaz 4000000
Gatham 000000
p ? Metiapolis 8000000 bt
s DR LS |
Progress W

Once a dataset is defined, using it in steps or filters is very easy using the following syntax:
dat aset _nane[row_i ndex] [ col um_nane_or _i ndex] .

General Properties

@J Properties commaon ta all event types.

Event Source |DE|M Ewvent v| Window |EI - | = 111 -
Ewvent Tupe ||:hange LT | Ken | L | Ny 27 -
Frame | w | Modifiers | v | Thirk.
DOk Properties
'@ DOk properties uniquely identify an element and itz value on a page.

Il | hittp: Ay, google. comd w |
WPath | //INPUT[@name=q] v | [ Browse |
Yalue |{{u:ities[i++][F'u:upuIatiu:un]}}| w |

Tag  |INPUT | Type |text |

This allows you to retrieve data at any specified row and column without having to advance the dataset automatically. You simply need to keep
track of an index to get to the desired row. However, if you want to automatically advance or go back, the syntax also supports the operators ++
and — as pictured above.

Something like ci ti es[i ++] [ Popul ati on] will get the value at the i-th row in the Population column and increase i by one for next time it is
used. As a convenience, 1-letter variables used as integers like i will automatically be defined and set to O if they haven't been defined before.

Finally, the syntax ci ti es.| ength orcities. count can be used to determine the number of rows in the cities datasets. This is useful to write
exit condition assertions when iterating over a dataset (e.g. Ifi More Thanci ti es. | engt h Then Go To event xyz).



In addition you can use of the global lisa scripting object. Of interest here are the following methods: download, open,

fileQuery, dbQuery.

download: allows you to dowload a resource from a given url to the specified path, so you can interact with it, using for example:

L]

® open: will read the contents of the specified file and return it as a string.

* fileQuery: will execute a SQL query against an Excel file and return a javascript dataset.

* dbQuery: will execute a SQL query against a Database file and return a javascript dataset.

All of these functions can be used from the Immediate debug window or script steps or filters. For example, here is how you would use download

and open from the Immediate window:

Output | Immediate |

liza. download("http: /A, google.com',''c: vhaooagle. htrml )
0k,

google=liza.open|"'c: Mhgoogle_ html');

<htmls < heads <meta http-equiv="content-type"" content="text/html; charset=150-8859-1" < title Google: Aithes < stuler body td.a.p,. hib
function sH{document.fg. focus()

windaw, gbar=1} {function(J{var c=window. gbar e.g.h:c. ge=function[alivar d=window. encodelRIComponentt&document. farms[0].ql"

[ >

Similarly, if you created a script filter called google, clicked on Browse to bring up the script details popup, and clicked the Evaluate button after

typing the script return lisa.open(“c:
google.html"), you would see the evaluation results:

3% Javascript Filter r-_|rﬁ|

Help | S0OL generators

@ The filker value will be determined by the return staternent of the javascript snippet below
The zpacial variable _arg references the DOM element of the filler,
The special vanable hiza iz 2 global object that provides wtility functions to perform =PATH or SOL quenies.

Y'ou can wse the other tab(s] to generate predefined code blocks

<html> < head: <meta hitp-equiv="content-type’" content="texthirml;

I:P}usct=l S0 -3}&55-1 "3 tither Google< Mitles < stylex body td, & p, hifont-family: anal, sanz-senf}. hifont-zize; 20px). hicolor #33660c)
glcolorHO0c) ts

b padding: 0} ts{bordercollapsescollapsel. Inc: ik, Inc:visited{ color #00c} pgtab, pgtab:hover,, patabs elected, patabside{text-
aligre centertest-decaration: none color B00c display block height: 27 pefloat: leftoverfiow hidden back ground: wll /intl/ja/image
#/productlinktabz prg) no-epeat padding-top:Bps}. pgtabivadthc 1 20px back ground-pozition: -27 4pyx

0}, patab: howvet (width: 130ps backaround-poasition: -144pu

0} pgtabselectedwidth: 1 44px}, pgtabsidelwidth: 3pxback ground-positior: -4 04px

(}icontovertlow: bdden:height: prcwidth pepositiorcrelativelobariflost left-height 22px padding-eft 2ps). gbh. gb2
diviborder-top: 1px solid #9471 font-size: 0height: 0F. gbhiposibore abzolute top: 24pewidth: 100%} ab2

)

l Evaluate ][ Save J[ Cancel

From that point on, this html string is available as googl e. The other 2 functions, fileQuery and dbQuery can be used similarly, but there is a tab
in the script details popup called SQL Generators that helps you generate the calls. Filling the properties at the top and clicking Generate From

Query yields a script snippet:


http://www.itko.com/download/release/lisa_browser/docs/web20howtos.html#lisa
http://www.itko.com/download/release/lisa_browser/docs/web20howtos.html#download
http://www.itko.com/download/release/lisa_browser/docs/web20howtos.html#open
http://www.itko.com/download/release/lisa_browser/docs/web20howtos.html#fileQuery
http://www.itko.com/download/release/lisa_browser/docs/web20howtos.html#ds
http://www.itko.com/download/release/lisa_browser/docs/web20howtos.html#dbQuery
http://www.itko.com/download/release/lisa_browser/docs/web20howtos.html#ds

0% Javascript Filter

Help | SOL generators

@ FleDaaSouce  |CA\iko\TKO phore,_list APR_0Bls v

() DB Data Souce onnection String

SELECT *FROM [Employes Phng]

Genarate from Quen:

I | Fiesults |

Jd

return liza, MleCuen"C:hitkob T KO _phone_list_APR_08 k" "SELECT * FROM [Employes Phndl ue);

Evaluate H Save H Cancel

which in turns evaluates to the following dataset:

4o Javascript Filter

Help | SOL generators |

© FileData Sowce | C:\itkoNTKO_phone_ist_4PR_D8.xs v| [ Browse |

() DB Data Source <Connection String:

SELECT * FROM [Employee Phng]

Generate from Queny:

S
Marme A Dept Mabile Horme Office Home AlM 1D —
Andy Mguyen Fre Sales 408... 408..... ah... |
Audrey Doucet Training 972 214 aurl |
Brad Rogers [a 303 303 brz...
Brian tMcDonald Development 12 Bl12.. 12 bri ...
Brian Spek Sales an4... EFA...
Cameron Bromley D eveloprment Austr... B1-... E1- ... car:, ~

[ Ewaluate ] [ Save ] I_ Cancel

Using the dataset API, you can create other filters and assertions to use the dataset. Let's assume the above dataset is saved in the enpl oyees

filter. For example, all the following expressions are valid to use in a filter script:
return enpl oyees.count(), return enpl oyees.rows(0).cells(0), return enpl oyees.rows(0).cells("Name"), etc...


http://www.itko.com/download/release/lisa_browser/docs/web20howtos.html#ds

(%) Script return femplopess Y rows(14). cells[ "M ame"] v

) Expression Browse
i) Cache

Quick Test

'if_’_;:' Click Evaluate to zee what value thiz filker would return if it were evaluated during the rec...

Recarded Yalue JD Dahan

[ Evaluate ][ Clear Al

This makes it extremely easy to parametrize data and loop through datasets. This type of dataset is akin to a Local Lisa dataset since its data is
not shared across test instances, but you have explicit access to any row or cell instead of implicitly moving to the next record on a given step.

18. How To - Run Load Tests

How To - 18. Run Load Tests

Starting in LISA 4.6, running web 2.0 load tests is supported in the same way as other steps, by specifying the desired number of virtual users in a
staging document. Each virtual user runs a separate browser instance, which consumes a fair number of resources, so there is a hard limit of 40
virtual web 2.0 users per machine.

If your test is purely web-based, by running in dual IE/Firefox mode, you can double that number without using much more resources.
Similar considerations apply for running other GUI technologies (Applets, Swing, .NET, Native, etc...). Multiple instances are supported up to point
that is mostly determined by available hardware.

Several settings control how multiple instances run (sandboxed or shared, under which user account, etc...). Those can be consulted in the Web
2.0 architecture section.

If you are using LISA 4.5 or earlier, read on...

Currently web 2.0 steps do not support multiple virtual users running them in parallel in the same JVM (typically it will cause an error dialog to pop
up stating there is a socket or listener error if you try to do so). You can still run multiple instances of the DOM browser in parallel, even on the
same machine, provided you use one per simulator (i.e. one per JVM).

The other option is to run in headless mode. After a web 2.0 test is recorded and saved back to TestManager, the boolean variable HEADLESS
will be added to the configuration (with a value of false by default). If you change that to true, web 2.0 steps will be replayed without the DOM
browser, using the pure java javascript engine Mozilla Rhino and the htmlunit java library.

The advantages of this approach are:

® you can run true load tests (multiple vusers per JVM).
® itis platform-independent
® it can simulate multiple browsers (by setting the BROWSER configuration variable).

The disadvantages are:

® some sites do not work well with it (the more complex the javascript they use, the more likely it is they may have problems).

® itis relatively heavyweight so don't expect to run hundreds of vusers on the same machine (dozens on a standard desktop is realistic
though).

® it doesn't support frame (currently), authentication (currently), applets (currently) or Active X controls (never).

Finally, load testing in GUI mode is going to be available as well, but is only doable in standalone mode at this time.
Running lisa_browser.exe -m drive will launch the multi-instance driver:


http://www.itko.com/download/release/lisa_browser/docs/web20.html#architecture
http://www.itko.com/download/release/lisa_browser/docs/web20.html#architecture
http://www.mozilla.org/rhino/
http://htmlunit.sourceforge.net/

3 Lisa Web Driver (4.5.0.2) E|FE|E|

= NewlInstance {7 kil Instance [Open Test » RunTest (ClDebugTest W Stop Test S Reset Test 5 E
b4 LISAWEBD Inztance Time Meszage Typs |
JERLISAWEE LISAWEBT 5/30/2008.. Loaded C:\waitForSplash rec

LISAWEBD  5720/2008, . Test waitForSplashrec started 3
LISAWERT  2/30/20068,. Test waiForSplashrec started

LISSWEBD S/30/2008... Ewculing Bucket 0] navigate (o Await hirnd]...[559 ms]
LISAWEB] 5/20/2008.. Exculing Bucket 0] navigate [c: /vt Himl]._[781 ms]
LISAWEBD  5/20/2008.. Ewculing Bucket 1] click on DIV [Loading... | [224 ms] }
LISAWERT 5/20/2008.. Excubrng Bucket 1) click on DIV [Loading... |..[235 ms] .
LIS&WERT  5/30/2008.. FILTER:Mavascript waitForSplashGonelwaith oS plas :
UsAWEBD 573072008, FILTER: Javascrot walForSsplashzone]watf orSplas..
LISAWEBT S/30/2008... Exculing Bucket 2) click on BODY [Helo Loading. ).

LISAWEBD  5/30/2008... Excubing Bucket 2 click on BODY Helo Loading... |..... 3
LISAWEBT  5/20/2008.. Test waitForSplazhrec ended ]
LISAWEBD  5/20/2008, . Test waitForSplazhrec ended ¥

Then you can add as many instances as you want of the DOM browser (in our environment it was able to handle up to about 40 instances), then
load a test and run it. All instances will run it in parallel and report the results as they go.
If you run in dual mode (IE + Firefox) you can double your number of clients with little overhead (so up to about 80 per machine).

More specifically, you can control through command-line parameters how to start those instances:

Lisa Browser Help [5_<|

i ] lisa_browser,exe [-m =recorder|playvback|drive |update =] [options]

where:

-m recarder launches the recarder

-m playback launches the debugger

-m drive launches the load test consale

-m udpate launches the software update dialog

and options are one or more of the following:

-a <true|false = aukstarts the test specified by -F in plavback or drive mode - defaulk is False
-n <nurnber = is the number of instances to autostark in drive mode - default is 0

-f =Ffile path= specifies a recording file to load on skartup - default is none

-t =file path= specifies a config file to load on startup - defaulk is none

-i <true|false > makes the driver console invisible in drive mode - default is False

-x <true|false > autoexits the program on test end if it was aukostarted - default is true

There is also a way to specify an xml file that contains a list of instances along with test files (and optionally config files) they need to run. Users
can also be specified if you need a test to be run in the context of a given user (typically useful for websites with windows authentication).
The syntax of this xml file is:

<staging>

<instance username="ul" password="p1" file="testl.rec"/>

<instance username="u2" password="p2" file="test2.rec" config="config2.config"/>
<test file="test3.rec" config="config3.config" instances="2"/>

</staging>

and it can be invoked as lisa_browser.exe -m drive -stg stagingfile.xml

All instances run in a separate windows user account (dynamically created and deleted as needed), so cookies and cache don't overlap between
instances. The advantage of this appraoch is that it supports everything the DOM browser supports in single mode.
The top-right icons allow you to pin the driver window on top and to hide all the DOM browsers as they run the test, making it look headless.



Finally, when the running tests are over, xml reports will be generated in the out directory. A default xsl stylesheet is provided to render the report
as html but it could be customized to any other rendering as all the data is present in the xml.

LISA Web 2.0 report for [google]

Test Statistics Test Graph
Test Nanme google
Start Time TOAE72008 11:24:2% AN
End Time 10/ 2008 11:24-40 AW
Instance Count 5
Transactions &0
Average Transartion Duration 412 ms —
Failwres 5 0 1 2 3
Event Transactions Faillores Min(ms) Max(ms) Avgims) StdDev (ms)
0) mavigate (http: /www.google, com) 13 0 546 2187 345 508
1) click on INFUT type=text 15 1} 1] 16 2 5
2) change on INFUT type=text (itho) 13 5 47 93 53 12
3) click on INFUT type=submit (Google Search) 15 0 359 747 4% 17

Note: load tests in drive mode currently require you to be logged in as administrator on the computer.
19. How To - Run in a non-privileged account or on 64 bit platforms

19. How To - Run in a non-privileged account or on 64 bit platforms

Q: Can the web 2.0 step be used on non-administrator accounts?
A: Yes, it can be run even in Guest accounts but will require a bit of environment configuration:

1) Port specification
By default, the LISA browser uses dynamic ports to communicate with LISA. If some ports are locked down, you can assign them instead using
the lisa.browser.source.port and lisa.browser.target.port properties (in the lisa.properties or local.properties).

2) Add permission for port listening

Some accounts may not have enough privileges to listen on a specific port (typically causing an Access Denied error). To add this permission,
use the httpcfg.exe tool (available at
http://lwww.microsoft.com/downloads/details.aspx?familyid=49ae8576-9bb9-4126-9761-ba8011fabf38&displaylang=en) and run the following
command: httpcfg.exe set urlacl /u http://+:8098/ /a D:(A;;GX;;;WD) where you replace 8098 with the port you specified in step 1) as
lisa.browser.target.port.

Note: a message box containing these instructions will appear the first time the error is encountered during a LISA run.

3) Register Tidy COM component

The LISA browser uses the w3c Tidy COM component to identify warnings and errors in the HTML code, as well as reformat it. This component is
dynamically registered but if the account does not have the sufficient privileges to register a COM component, you should log in as administrator
and run the command: regsvr32 \bin\browsen\TidyATL.dll

Note: a message box containing these instructions will appear the first time the error is encountered during a LISA run. If no action is taken the
web 2.0 step will still be functional but missing the above functionality.

Q: Can the web 2.0 step run on 64-bit platforms

A: Yes, it can. The only thing to be aware of is that the component used to display the HTML source during test authoring will be disabled, but it
should not affect running the test in any way.

20. How To - Record and replay against non us-english websites

20. How To - Record and replay against non us-english websites


http://www.microsoft.com/downloads/details.aspx?familyid=49ae8576-9bb9-4126-9761-ba8011fabf38&displaylang=en
http://+:8098/

Using Web 2.0, there is nothing special you need to do to record and replay against websites that use any language or locale. Of course, to see
the right glyphs on the screen you will need to download the language packs corresponding to the appropriate codepage, but if you can see them
correctly in a browser, it means they're already installed.

The following screenshots show the DOM browser and TestManager after it recorded and replayed a test against a japanese website.
Authoring and evaluating a filter during recording:

Froperties

@ A tewt filker retrieves the inner text of a DOM: element uzing a regular exprezsion [first captuning group).

3 DOM Element |H.J'TABLE[@id='cuntent-table']f’TBEID‘T'.-’TFE[‘I]f"TD[2].J'TABLEHTBEIDWTFUTDHH‘I vl[ Erowse ]

Text [ i~
® ~
Githibe e
) Seript ; Browsze
{4 Ewpression W Browse
3 Cache At

[uick Test

@ Click Evaluate to see what value this filter would return if it were evaluated during the recording.

Fiecorded Walue |L}J?ﬁ".‘)"ﬂf)[£'3t‘lt |

Ealuate ][ Clear &l ]

Replaying the test in the DOM browser while showing debug events:

Logical Events | ‘afeh |HTML|

@ 0] navigate [http:dfw
1] click on & (LA

2] click on H1 (L7
. ick an H L. I

mdcontinue (quiet) || [ by | mE | HR-ba Aok | TATAYUE | LR Tt
E}mntinue W
0 | e e PRSI ITATINT =
@ »r =2 ! < | )
Output | Wariables || Immediate |

| Time T! Message i’
1328 &‘ Executing DOME vent: [BID: O)[FPATH: [TYPE: click][PATH: A/TABLE[@id="content-table’l/TBODY TR[1]/TD[2]...
1328 O [Bucket Duration: 1062 mz]

1328 &8 FILTER:[Text: fiter click 8214062 fileer. click 821 4062=1 /75 T /4242000 ]

[

Replaying the test in the ITR after saving it to TestManager:



Execution History

0 navigate (http://{4{SERVERD}:Hip/ia/index, html

1) click an & {1 2 - 22 M 2 TT)

Ziclick on HL (L5« 35 08 i 00T
ckon HI (L i )

end

Response | Properties | Test Events

editing an existing key.

Initial property walues may be changed prior to executing the step, They are rea

Key w» Walue
LaLE true
| BROWSER Firefiox
[[HEADLESS False
(lLaSTRESPONSE <HTML lang=ja xml:lang="ja" xmins=
L5 _HosT dude

[lLIzA_LAST_STEP

3y click on HL (L~ 2%« 334 M A0

[lLIzA_T_PATH

i\ Tempirand

|ILISA_USER id
SERYERD i, lenovo, com
SERVER.1 =06, ibm, com
event.path I TABLE[@id='content-table' ] TBODY,

event . response

<HTML lang=ja xml:lang="ja" xmins=

event.status, code

200

event.type

click.

event.url

hiktp: | frmen-06. b comyjp/peflenowo

| filter. dlick. 5214062

Le A5 S a0 i T

21. How To - Run in Crash Dump mode

21. How To - Run in Crash Dump mode

The LISA browser runs mostly in managed code but due to external native libraries bugs and portions running native code (e.g. ActiveX, Applets,
jdglue, etc..), it is possible to sometimes observe crashes in certain environment and under special circumstances (those will usually manifest
themselves as AccessViolation exceptions.

To facilitate resolution of those errors, the browser supports running in Crash Dump mode. When these errors occur in Crash Dump mode, the
browser will generate a large dump file that can be later analyzed to identify the root cause of the issue. To turn on Crash Dump mode, follow
these instrunctions:

1) Download Windows Debugging Tools at the following location: x86 or x64.

2) Define the _LISA_CRASH_DUMP environment variable to be the Windows Debugging Tools install directory
(e.g. _LISA_CRASH_DUMP=C:\Program Files\Debugging Tools for Windows (x86)).

3) Restart LISA

When a crash occurs, it will generate a large (> 100MB) .dmp file in the directory <LISA Install Dir>\bin\browser\out\Crash_Mode_
Date_xx-xx-xxxx_Time_xx-xx-xxXX. This is the file that support will need to resolve the issue.

Note: the first time the browser runs, it may fail because it will auto-download a lot of large symbol files from microsoft servers. It should behave
normally in subsequent runs (except maybe for a minor slowdown). When the problem is resolved you can unset _LISA_CRASH_DUMP to return
to normal operating mode.

PART 3 - LISA Web 2.0 - Reference

PART 3 - LISA Web 2.0 Reference

The following topics are available.

1. Recorder Reference

2. Debugger Reference

3. Settings Reference

4. XPath syntax Reference

5. Scripting Objects Reference
6. Command line Reference

1. Recorder Reference


http://www.microsoft.com/whdc/devtools/debugging/installx86.mspx#a
http://www.microsoft.com/whdc/devtools/debugging/install64bit.mspx

1. Recorder Reference

‘W'iE DTM 'HT"- F'LLrSINE Il AHTETS_ S‘-ATINE_ .NFT ] E‘JjNTS_
1§ 47 18 19 20 # n 2
24 ]
UULW Imniaechate |
Tinne Type | Mezzaps e
16105812 L0  Received Swing Evert: [BID: DJFPATH: [TYPE: focusin]|PATH: Aavar. svind.JFramea/jay e swing JRoctPanefjavar. swing.L..
181506521 L0 Recsived Swing Evert: [BID: DFPATH: [TYPE: mouseowei][PATH: Aavax swing JFrame/java swing JRootPanejavar swing..
161506953 &4 Received Swing Ever: [BID: OYFPATH. ITYPE: mouseaut[PATH: favax swing JFrame/favax swingJRoolPanefavanswing...
Progress | g Digne Ll |
| ! L
6 a % ™
1. Browser back button
2. Browser forward button
3. Browser reload button
4. Browser cancel button
5. Browser address bar
6. Browser navigate button + drop-down to navigate file system for html, exes and bat files
7. Open existing recording
8. Save current recording (+ drop-down to recording file or to LISA or save capture file)
9. Close browser button (+ drop-down to clear all events)
10. Pause/Resume recording button
11. Debug button to toggle debug view (24, 25)
12. Settings button to bring up Settings Dialog
13. Pin button to force browser on top
14. Toggle button between recording and playback mode
15. Help button to open the help files
16. Web tab to record web site tests
17. DOM tab to inspect live instance DOM tree
18. HTML tab to inspect live instance HTML sources (static, dynamic and script)
19. PLUGINS tab to inspect live instance plugin objects in
20. APPLETS tab to inspect live applets hierarchies
21. SWING tab to inspect live Swing applications hierarchies
22. .NET tab to inspect live .NET WinForms applications hierarchies
23. EVENTS tab to edit and parametrize the currently recorded test
24. Debug Output window to see all log and error messages
25. Debug Command window to evaluate commands
26. Browser download progress bar
27. Browser status text

. Browser status icon (loading, no errors, errors)
. Browser javascript debugging menu

2. Debugger Reference

2. Debugger Reference



arenapds  Flayback  Help
@ D R i | Addess g Povbek & @ 8 Q @] & O 0]
Logical Events || @8 eb |3 HimL| & :T;us @ Swing | @ NET
@'..--_if- bl e ] [ r |
?a e :I__-_ 17 8 19 20 a1
15 16
o 28 29
2|23 m| 25 B
4[]} ] »
gl sle Bl R
.I:I:,II!IUII: Va-idLei Immediate
Time Type Message =
1650:35628 @ Ewecuting DOMEvent: [BID: DJFPATH: NTYPE: navigabe]PATH: JILOC: 0, 0ITHINK: B953[URL: ITAG: [[SUBTAG: JMALL...
1660:35937 @  Execuling DOMEvent: [BID: O[FPATH: TYPE: focusin|[PATH: MTML/RODYILOC: 479, 33[THINK: 78JURL: sboutblan...
1650:35031 & Executng DOMEven [BID: OFPATH: ITYPE: docloadIPATH: JILOC: O, DITHINK: 1E]IURL: about blsk|[TAG: [SUBTAG.. +
Progress I Dq:"ne
| T
30 3
1. Browser back button
2. Browser forward button
3. Browser reload button
4. Browser cancel button
5. Browser address bar (disabled in playback mode)
6. Turn on/off Internet Explorer as a replay environment
7. Turn on/off Firefox as a replay environment
8. Turn on/off Safari as a replay environment
9. Enable/Disable mouse movements during test execution
10. Debug button to toggle debug view (24, 25)
11. Settings button to bring up Settings Dialog
12. Pin button to force browser on top
13. Toggle button between recording and playback mode
14. Help button to open the help files
15. Set/unset Breakpoint
16. Web 2.0 event (LISA step)
17. Browser tab to host web steps execution
18. HTML tab to inspect live instance HTML sources (static, dynamic and script)
19. APPLETS tab to inspect live applets hierarchies
20. SWING tab to inspect live Swing applications hierarchies
21. .NET tab to inspect live .NET WinForms applications hierarchies
22. Execute highlighted step
23. Execute All steps starting at the highlighted one until breakpoint or end is reached
24. Stop current step execution
25. Reset test: blanks out browsers, clears variables, outputs, etc...
26. Save button (disabled now)
27. Debug Output window to see all log and error messages
28. Debug Variables window to see all current variables and their values
29. Debug Command window to evaluate commands
30. Browser download progress bar
31. Browser status text

3. Settings Reference

3. Settings Reference

Most of the settings have been mentioned in the documentation or the how-to's but this is the full reference for them.

They are divided in 4 sections: General, Recording, Playback and Environment.



For an online help, click on the icon in the top right corner of the settings screen and then on one of the fields, to get a tooltip which gives
more information about it as shown below:

General Settings:

General | Recording || Playback | Ernevironment

Information

BUILD: hiza_browser, Werzsion=4.5.1.0, Culture=neutral, Publick.epT oken=rnull
MACHINE: DUDE

05: Microzoft Windows MT 51,2600 Service Pack 2

IE: B.0.2300.2180

JRE: 1.E.0.B

E=E: "C:\itkomain'liza-webhliza-browsersbiniD ebug'liza_browser vshost exe'

MEMORY": 105644 KB

General Behavwior Log Sethings
[] Disable browser popups Log Meszzages to Quput Window
[] Erable Active / Flash / Flex [beta] Log Messages ta fils
[] Enable &pplets (%) Debug Level
[] Enable 54T [alphal i3 Info Level

Enable Eclipze [alpha) 73 wWaming Lewvel
Capture HT TP traffic L Ceael el

Log statements of severity Emor

Enable Fathfinder |nteagration and higher
Remote Applications Port [0 o
b airnurn B andwidth 1] = | EB/s

Disable browser popups: acts like a popup blocker. Overrideable in a test with DI SABLE_POPUPS.

Suppress Javascript Dialogs: alert and confirm dialogs will auto-respond during playback SUPPRESS_DI ALOGS.

Enable ActiveX / Flash / Flex: Turns on support for ActiveX events. Only reason to turn it off might be faster startup time.

Enable Applets: Turns on support for ActiveX events. Only reason to turn it off might be faster startup time or improved stability (the

Java Plugin Interface has some known bugs in certain versions of it, notably 1.5.0_01 through 1.5.0_14, that could cause crashes).

Enable SWT: Turns on support for testing non-Eclipse based SWT applications.

® Capture HTTP traffic: Turns on a proxy to capture all HTTP(S) traffic and stores all headers in the event requests. Only reason to turn it
off might be faster startup time or already having a proxy.

® Enable Pathfinder integration: this causes the browser to receive and decrypt Pathfinder payloads for Pathfinder-enabled applications.

Remote Applications Port: specifies the port to use the control remote applications (Swing, SWT or WinForms). The default, 0, picks

the port dynamically.

Maximum Bandwidth: throttles request and response speed to simulate a network with the specified throughput. 0 means no limit.

Log messages to Output window: self-explanatory.

Log messages to Output file: self-explanatory. The log files go in the same directory as the DOM browser.

Log Level: the level of log statements required to be logged in the Ouptut window or file if turned on above.

Recording Settings:



Genere_nl Fecording F'Ia_l,ll_:uau;k I_Envin:unme_nt:

Fecarding Options

Usge context menus for filkers and assetions [ | Capture HTML changes

[ Capture applet shapshots Capture Diff Size : 0 | | Butes

] Compress recarding files Capture Max Time | ms

Werboze recording

Save Dikog Trggers [\ S docSi st ot

Recarding Strateqgy Capture DOM Events
I1ze the following attibutes [in thiz order): navigate docload
1) &) [<none> 8| focus dblclick
: | v v

2] N p— mouzedowh change

- . - — MouzeLp contestment
3 <noner % Tl [<roner W

B —— - ] mioUseoyer drag/drop
4] |<nones W al

g — [] mousecut [] mousemove
Except thoze whose value matches: click kevpress

| velf3.H_idigenl\d+Idialog. opendciose [] ajax callback

For Jawa Swing and Applets, record:

Componert hames Compaonent text

Use context menus for filters and assertions: Override the right-click menu in web pages to popup a custom menu that offers choices
about filters, assertions or debugging. Turn it off it your site already uses custom context menus.

Capture applet snapshots: stores in the test the applet screenshots used in applet test editing (browse mode). Turn it off if the tests get
too large.

Compress recording files: keep that turned on (used for debugging).

Verbose recording: Records events for which we could not detect an event handler (possibly DOM Level 2). Turn it off for most sites, try
to turn it on if you notice some necessary event does not get recorded (happens using ExtJS for instance).

Capture HTML changes: Store the HTML at any click or change event to make it easier for later editing.

Capture Diff size: changes over this size will store the whole response, changes under this size will stotre the diff.

Capture Max time: the diff above won't be captured if it takes more than this amount of time.

Save Dialog Triggers: for pages with a non text/plain mime type, this decides whether to pop up a "Save As" dialog instead of
performing a navigation if the target url matches the regular expression (by default, it does this for Excel, Word, PDF, Text, PowerPoint,
Executable and Zip files).

Recording strategy: which HTML attributes to use and in which order when generating XPath expressions.

Exclude Ids matching: any element id matching this regular expression won't be used in the auto-generated XPaths.

Record component names/text: use java component names or text (or not) in the XPath generated when recording Java based
applications.

Capture DOM events: Turn off any type of DOM event you're not interested in capturing.

Playback Settings:



General chu:_uru:_ling: Playback | Environment |

Flayback Options Timeout Settingz

[] Supress Javascript Dialogs DM Load Timeout 10000 2| me

[ Fail step on missing target. DOM Lookup Timeout (1000 # | ms

[] Synchranize Ajax calls. .

[ Use Hardware Input Applet Load Timeout _SEIEIEI | ms
Send Commands Asynchronously &pplet Lookup Timeout (3000 2| ms

[] Send Responzes back to LISA

Min matching score |1 - ActiveX Load Timeout 10000 & | ms

Activex, Lookup Timeout (5000 2| ms

Default Browser Mode

[] Intemet Explarer

[] Firefox
[] Satari

Flayback Speed

Wait mulkiplier: 0=

® Fail step on missing target: Generates a failure instead of the default warning when a target can not be found for a step (that includes
browser window, frame, element). Overrideable in a test with FAI L_M SSI NG

® Synchronize Ajax Calls: forces all ajax calls to be executed synchronously. Overrideable in a test with SYNC_AJAX.

® Use Hardware Input: Replays tests by controlling keyboard and mouse. Overrideable in a test with USE_HARDWARE.

® Send Responses back to LISA: By default responses will not be sent back to LISA to improve performance and memory since it's
usually not necessary.

® Min Matching Score: How many differences are allowed between a recorded XPath value and the best match found during playback.
Overrideable in a test with M N_BACTRACKI NG

* Default Browser Mode: What browsers to enable by default during playback (pipe-delimited combination of IE, FF and WK).
Overrideable in a test with DEFAULT_BROWSER.

® Playback Speed: The default speed to use to replay test as a multiplier of the recorded speed. Ox is usually the best choice.
Overrideable in a test with PLAYBACK_SPEED (integer between and 10).

® XXX Load Timeout: The maximum amount of time waited before a new page/applet/control load before proceeding. Overrideable in a
test with XXX_LOAD_TI MEQUT.

® XXX Lookup Timeout: The maximum amount of time waited to find an element on a page/applet/control before proceeding.
Overrideable in a test with XXX_LOOKUP_TI MEQUT.

Environment:



General | Recording F'la_l,ll:..?._:k' Enviranment
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This tab shows the list of global environment variables available to the browser, as read from lisa.properties and local.properties.

LISA Driver Settings:

In addition to the seetings above that can be overriden from LISA in a test case or in the local.properties, the following are available:

lisa.browser.launch.timeout: The amount of time allowed for a browser to launch (default is 10,000). Specify in local.properties.
lisa.browser.exec.timeout: The amount of time allowed for a step to execute (default is 300,000). Specify in local.properties.
lisa.browser.max.instances: The maximum number of browser instances per machine (default is 25). Specify in local.properties.
lisa.browser.client.user.single: Whether to run staged browsers using the same user account as the currently logged-in users (default
is true). Specify in local.properties.

lisa.browser.base.port: The first port to use in the range of ports available to control web browsers (default is 0 for dynamic value). This
normally does not need to be modifed except in very secure environments that lock down some local ports. Specify in local.properties.
lisa.browser.client.user.<user name>=<encrypted password>: when lisa.browser.client.user.single is set to false, browser instances
will use the specified windows user accounts to run tests. If not enough user accounts are specified in this manner and the currently
logged-in user has admin privileges, user accounts will be dynamically created to run the tests (and deleted at the end). To obtain an
encrypted password, run the command line: lisa_browser.exe -m encrypt -in <clear text>.

lisa.browser.share.subprocess.state: Whether to run a sub-process using the same browser instance as parent test (default is false).
Specify in configuration of sub-process.

lisa.browser.swing.port: The first port to use in the range of ports available to control Swing applications (default is 0 for dynamic
value). Specify in local.properties.

lisa.browser.base.port: The first port to use in the range of ports available to control web browsers (default is 0 for dynamic value).
Specify in local.properties.

4. XPath syntax Reference

4. XPath syntax Reference

The XPath syntax supported to identify html elements in web 2.0 tests is a subset from the standard XPath specification, as described at XPath


http://www.w3.org/TR/xpath20/

2.0 specification. Roughly speaking, the supported vs. not supported functionality is as follows:

<Tagl>/<Tag2> to look for an element child is supported (e.g. TR[1])/TD[2]).

<Tagl>//<Tag2> to look for an element descendant is supported (e.g TABLE//INPUT).

.. to select the parent of an element is supported (e.g. TABLE//TD[@id="abc']/../TD[1])

>> and << to select the next and previous sibling of an element respectively are supported - the standard axis names following-sibling or
preceding-sibling can be used instead with >> and << just being shorthand for it - (e.g. TABLE//TD[@id="abc']/../>>/>>/TD[1])).
<Tag>[@AttributeName="'AttributeValue'] to look for an element with the specified tag meeting the AttributeName="AttributeValue'
condition is supported (e.g. INPUT[@id="abc"]).

<Tag>[text()="innerText'] to look for an element whose inner text equals the specified one is supported (e.g. TD[text()="Hello"]).
<Tag>[matches()="regex'] to look for an element whose inner text matches the supplied regular expression is supported as a proprietary
extension (e.g. TD[matches()="s*Hello\s*1).

Other XPath axes are not supported.

Only XPath expressions returning a unique node are supported. Expressions returning potentially multiple nodes will simply return the
first one matching the expression.

XPath functions (in the fn: namespace) and operators (arithmetic or boolean) are not supported.

5. Scripting Objects Reference

5. Scripting Objects Reference

Both in its debug window, and in its script filters, the DOM browser supports standard javascript and java (beanshell) syntax, but additionally
built-in commands and some useful objects are defined with the following APIs:

_arg: A DOM element, or Java component, or ActiveX accessible element which is specified either as the element in a filter, or is the last recipient
of an event in the Immediate debug window while recording or debugging.

lisa: A global javascript object available on every HTML page:

public object dbQuery(string connectionString, string query, [Optional] bool cache)

Given a database connection string and a SQL query (and optionally a boolean to indicate whether to cache the results), this will return a
DataSet object (see reference below).
public void disableBlur(bool disable)

When passed true, this will disable all the onblur event handlers on any subsequent page. This can make it easier to debug or add filters
on popup menus that would otherwise disappear when losing focus.
public string download(string url, string path)

Will download the resource at the given url to the specified path. Useful to download files without having to go through the Save As
dialogs.
public object fileQuery(string path, [Optional] string query, [Optional] bool cache)

Generates a DataSetWrapper (see reference below) from an Excel file and optionally a SQL query and a flag to cache the results. If no
query is given, the whole first worksheet is returned in the dataset.
public void fire(HTMLDocument document, string xpath, string evtName)

Manually fires the supplied event on the element identified by the specified xpath.
public string open(string path)

Returns the contents of the file at the specified path into a string.
public string pathfind(string xpath)

Returns the node value of the event . pat hf i nder xml selected by the specified xpath expression.
public void print(object 0)

Prints a textual representation of the argument to the debug Output window.
public object select(HTMLDocument document, string xpath)

Returns the html element by specified xpath.
public string showHandlers(HTMLDocument document, string xpath)

Returns a list of all the javascript functions used as event handlers on the specified elements and all its parents.
public string upload(string url, string path)

Similar to download, but uploads a resource from the specified path to the specified url.
public void evaluate(string code)

Executes arbitrary C# .NET code. Can be used as last resort if desired functionality is not available.
public bool compareFiles(string filel, string file2)

Returns whether the contents of filel and file2 are exactly identical.


http://www.w3.org/TR/xpath20/

public double diff(string filel, string file2)

public void jsimport(HTMLDocument document, string jsfile)

Returns a value that indicates how different the files are (based on their length, average value and standard deviation).

Automatically imports a js file into the specified page, making its variables and functions available to subsequent filters on the page. Note

that any .js files in the browser directory will be automatically offered as an import in the filter drop-down of DOM event filters.

public void javaimport(string javafile)

® Automatically imports a java source file into the currently running java process, making its functions available to subsequent filters in the
test. Note that any .java files in the browser directory will be automatically offered as an import in the filter drop-down of java event filters.

DataSetWrapper: A javascript class that encapsulate the result of SQL queries:
public string asText()

Returns a textual representation of the dataset where each cell is contained in brackets [ ].
public int columnCount()

The number of columns in the dataset.
public string columns(int index)

The name of the column as the specified index.
public int count() or public int length()

The number of rows in the dataset.
public object rows(int index)

Returns the DataRowWrapper (see reference below) object at the specified index.
public string toString()

A textual representation of the dataset.
DataRowWrapper: A javascript class that encapsulate a single row of a DataSetWrapper:
public object cells(object indexOrName)

°
L]
® Returns the value in the cell at the specified index or in the column with the specified name.
® public string toString()

°

® Atextual representation of the row.

6. Command line Reference

6. Command line Reference

lisa_browser.exe supports the following options:
lisa_browser.exe [-m ] [options]

Where:

-m recorder launches the recorder

-m playback launches the debugger

-m drive launches the load test console

-m udpate launches the software update dialog

And options are one or more of the following:

-a autstarts the test specified by -f in playback or drive mode - default is false

-n is the number of instances to autostart in drive mode - default is 0

-f specifies a recording file to load on startup - default is none

-c specifies a config file to load on startup - default is none

-i makes the driver console invisible in drive mode - default is false

-X autoexits the program on test end if it was autostarted - default is true

-stg specifies a path to an xml file that lists instances along with test and config files to use

See Load testing for the syntax required by the -stg option.

PART 4 - LISA Web 2.0 - Videos
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PART 4 - LISA Web 2.0 - Videos

http://www.itko.com/download/release/lisa_browser/docs/web20videos.html
The other information available at this location is not up-to-date. Please refer to the videos only.

NOTE: This site requires a valid login. If you have any questions, please contact your iTKO Sales Representative. Thank you.

PART 5 - LISA Web 2.0 - Repository

PART 5 - LISA Web 2.0 - Repository

The following topics are available...

1. Instructions

2. Always update

3. Update with major revisions changes

4. First time update (i.e. only if you're missing these files)

1. Instructions

1. Instructions

If you can not use the browser update mechanism for policy or connectivity reasons, you can download the updated files manually from this page.
There are no installations steps.

Simply download the following files to the directory: <LISA install dir>\bin\browser. The only exceptions are:
web20bridge.jar and jdbridge.jar that should go into the <LISA install dir>\lib directory
djbridge.dll and jdglue.dll that should go into the <LISA install dir>\bin directory

You usually have to download only a few files as indicated below. If you are unsure which ones to download, you can always download them all.
Using manual download, you are responsible for backing up the files you overwrite in case you need to revert later.

2. Always update

2. Always update

lisa_browser.exe
appletcallback.jar
swingcallback.jar
web20bridge.jar

3. Update with major revisions changes

3. Update with major revisions changes

applet-monitor.dll
dotnet-callback.dll
dotnet-monitor.dll

injector.dll
lisa_browser.XmlSerializers.dll
global-hook.dll

jdbridge.jar

djbridge.dll

jdglue.dll

4. First time update (i.e. only if you're missing these files)


http://www.itko.com/download/release/lisa_browser/docs/web20videos.html
http://www.itko.com/download/release/lisa_browser/lisa_browser.exe
http://www.itko.com/download/release/lisa_browser/appletcallback.jar
http://www.itko.com/download/release/lisa_browser/swingcallback.jar
http://www.itko.com/download/release/lisa_browser/web20bridge.jar
http://www.itko.com/download/release/lisa_browser/applet-monitor.dll
http://www.itko.com/download/release/lisa_browser/dotnet-callback.dll
http://www.itko.com/download/release/lisa_browser/dotnet-monitor.dll
http://www.itko.com/download/release/lisa_browser/injector.dll
http://www.itko.com/download/release/lisa_browser/lisa_browser.XmlSerializers.dll
http://www.itko.com/download/release/lisa_browser/global-hook.dll
http://www.itko.com/download/release/lisa_browser/jdbridge.jar
http://www.itko.com/download/release/lisa_browser/djbridge.dll
http://www.itko.com/download/release/lisa_browser/jdglue.dll

4. First time update (i.e. only if you're missing these files)

Interop.SHDocVw.dll
Interop.TidyATL.dll
Interop.WebKit.dll
Microsoft.mshtml.dll
SciLexer.dll

ScintillaNET.dll

TidyATL.dll
Microsoft.Office.Interop.Excel.dll
Office.dll

swt.jar

PART 6 - LISA Web 2.0 - FAQ

Q: Can | test Flash and Flex applications?
A: The answer is "it depends".

First let's clarify Flash vs. Flex: Flex is an extra layer on top of Flash that helps programmers render certain layouts and controls more easily
within a Flash VM. These days, non-Flex Flash applications are used almost only for video and/or animations so they are unusual in enterprise
applications, so I'll focus on Flex in the remainder of the discussion.

Generally speaking there are 2 ways to test or automate Flex applications:

- using the so-called MSAA (accessibility interface) which provides ActiveX control clients with some level of visibility inside them. Support for the
MSAA is pretty variable even within Flex applications, depending how they're coded and compiled. This means, in the best case that you can
have visibility into every label, button, text field, drop down, etc...or in the worst case that the whole component (or large parts of it) are simply
seen as graphics blobs. In the latter case all automation has to revert to coordinate based events and testing becomes very brittle, data can't be
extracted - other than using OCR (optical character recognition) which some vendors do, with little success. To get an idea of how much detail is
available in a given Flex app, you can download and use the accexplorer32.exe Microsoft tool.

This is the approach employed by the LISA browser: a Flash control (and thus a Flex one too) is embedded in a web browser as an ActiveX
control or a plugin, so the the LISA browser has visibility into it inasmuch as it can see ActiveX controls and their subcontrols. This generally (but
not always) is sufficient for small or simple controls embedded in HTML pages but rarely so for full-fledged apps that use the whole page or
complex controls. Unfortunately there is no way to tell in advance and you'll have to try it to find out (or use accexporer32.exe to have an idea).

The advantage of this technique is that it requires no code changes or recompilation of the Flex app to work, so it's been favored by many
vendors in the past (including QTP) but its limitations are starting to push some vendors toward the second approach:

- using a Flex agent that allows clients to communicate directly with the Flash VM and its controls, variables and functions. This is the approach
taken by vendors like GorillaLogic's FlexMonkey (or to a lesser extent Flex Selenium, which uses Externallnterface objects to access the VM
through javascript). When this approach is possible, it is much more robust and much preferable to the previous one, but as of Flex 3 it still
required instrumentation and/or recompilation of the Flex application. This may no longer be needed now or in the future but | am not sure about
the details.

We will probably invest into this alternative at some point but there is no ETA on this yet.


http://www.itko.com/download/release/lisa_browser/Interop.SHDocVw.dll
http://www.itko.com/download/release/lisa_browser/Interop.TidyATL.dll
http://www.itko.com/download/release/lisa_browser/Interop.WebKit.dll
http://www.itko.com/download/release/lisa_browser/Microsoft.mshtml.dll
http://www.itko.com/download/release/lisa_browser/SciLexer.dll
http://www.itko.com/download/release/lisa_browser/ScintillaNET.dll
http://www.itko.com/download/release/lisa_browser/TidyATL.dll
http://www.itko.com/download/release/lisa_browser/Microsoft.Office.Interop.Excel.dll
http://www.itko.com/download/release/lisa_browser/Office.dll
http://www.itko.com/download/release/lisa_browser/swt.jar
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